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In This Guide...
In This Guide...

Welcome to the User’s Guide for the Agilent 2100 Expert Software. This 
manual provides beginners and advanced users with information needed to 
successfully run electrophoretic assays with the 2100 Bioanalyzer system. The 
2100 Expert Software allows the control of the 2100 Bioanalyzer instrument 
(including diagnostic functions) and, in combination with an analysis kit, the 
acquisition, interpretation and result presentation of data generated during 
the analysis of DNA, RNA, and proteins.

1 Typographic conventions in this Manual     

This chapter shows you how to make efficient use of this manual.

2 Quick Start     

This chapter is meant for experienced users. It briefly summarizes the 
necessary steps to prepare and run an assay. Please note that in terms of the 
2100 Expert Software, a method resembles an extended assay, which also 
includes additional administrative data such as operator, instrument, 
reporting, and workflow settings. These additional functions are unlocked 
with the 2100 Expert Security Pack.

3 Looking at 2100 Expert Software     

Before you start running methods/assays on the Agilent 2100 Bioanalyzer 
system, you should familiarize yourself with the 2100 Expert Software. This 
chapter shows how to get started with the 2100 Expert Software, and outlines 
its main operational possibilities.

4 Running and Evaluating Electrophoretic Methods/Assays     

This chapter explains how electrophoretic measurements are made using the 
2100 Bioanalyzer system, gives detailed descriptions of all steps necessary to 
run electrophoretic assays, and shows how to analyze and evaluate results 
using electropherograms and gel-like images.
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In This Guide... 
5 Working with Chip Data and Methods/Assays     
This chapter shows you what to do to open, save, import and export files, and 
how to print the results.

6 Administering System Functions and the Security Pack     
This chapter is your guideline for configuring the 2100 Expert Software.

7 Running Instrument Diagnostics     
This chapter shows how to use the diagnostic tests to check the 2100 
Bioanalyzer instrument for proper functioning.

8 Performing Verifications     
This chapter describes how you can validate your 2100 Bioanalyzer system.

9 Products, Spare Parts, and Accessories     
This chapter lists all parts and accessories—including reorder numbers.
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1 
Typographic conventions in this Manual

This chapter shows you how to make efficient use of this manual.
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1 Typographic conventions in this Manual  
In This Guide...
This manual uses convenient online navigation features and follows certain 
typographic conventions.

If you have any questions this manual cannot answer, please contact Agilent 
for addtional support at: 
https://www.agilent.com/en/product/automated-electrophoresis/bioanalyzer-systems.

Table 1 Typographic conventions

Highlight

Italic • Emphasis 
Example: Right-click the ...

• Term 
Example: Dot plots show events as dots.

• Reference to another document
Example: Refer to the Agilent 2100 Bioanalyzer System Troubleshooting and 
Maintenance Guide.

Blue • Cross-reference or hyperlink
Examples:
“Introduction to the Key Features of the 2100 Expert Software” on page 26
https://www.agilent.com/en/product/automated-electrophoresis/bioanalyzer-systems

Courier Code
Example: . the command line parameter  
-port 2 ...

Courier 
bold

• User input
Example: Enter  
50 MB.

Bold On-screen element
Example: ... the OK button.
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2 
Quick Start
Preparing the Agilent 2100 Bioanalyzer Instrument     10
Switching on the Agilent 2100 Bioanalyzer     11
Running a Measurement     12
During the chip run     20
Viewing the Measurement Results     21
What You Can do When the Measurement is Finished     23

This chapter is meant for experienced users. It briefly summarizes the 
necessary steps to prepare and run an assay. Please note that in terms of the 
2100 Expert Software, a method resembles an extended assay, which also 
includes additional administrative data such as operator, instrument, reporting, 
and workflow settings. These additional functions are unlocked with the 2100 
Expert Security Pack.
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2 Quick Start  
Preparing the Agilent 2100 Bioanalyzer Instrument
Preparing the Agilent 2100 Bioanalyzer Instrument

1 Make sure a clean electrode cartridge is installed.

2 If you want to change the cartridge, follow the instructions in “Loading the 
Electrophoresis Chip into the 2100 Bioanalyzer Instrument” on page 63 .
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Quick Start 2 
Switching on the Agilent 2100 Bioanalyzer
Switching on the Agilent 2100 Bioanalyzer

1 Make sure the 2100 Bioanalyzer instrument is connected to line power and 
connected to the PC.

2 Turn on the line switch at the rear of the instrument.

The status LED at the front of the 2100 Bioanalyzer instrument should light 
up.

The status LED shows you the current status of the instrument.

Signal Meaning

Green light Instrument is switched on and ready for measurement.

Green blinking Measurement is running.

Orange blinking Instrument is busy (running self-diagnostic, for example).

Red light Instrument is not ready for measurement. Switch the 
instrument off and on again. If the problem persists, 
contact Agilent service.
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2 Quick Start  
Running a Measurement
Running a Measurement

1 To start the 2100 Expert Software on the connected PC, go to your desktop 
and double-click the following icon:

2 The 2100 Environment Checker (see “The 2100 Environment Checker” on 
page 28) will validate computer settings in the background. You might have 
to acknowledge these warnings before the software will start. 

3 The access to the 2100 Expert Software and its functionality is controlled 
by the installed Security Pack. You need to authenticate yourself with your 
user name and password.

For more information on the user management of 2100 Expert Software, 
see section Looking at 2100 Expert Software.
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Quick Start 2 
Running a Measurement
After startup of the software, you enter the Instrument context: 
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2 Quick Start  
Running a Measurement
The Instrument tab shows you the status of the 2100 Bioanalyzer instrument:

Icons Meaning

Instrument detected, lid is open.

Instrument detected. Lid is closed, but no chip is inserted.

No instrument has been detected. 
Check the COM Port setting (see figure under step 3), the RS 232 connection cable, the 
power cable or the USB connection, and the power switch. For details on how to set up 
the 2100 Bioanalyzer system and connect it to a PC, see Agilent 2100 Bioanalyzer System 
Installation and Safety Guide.

NOTE If you started 2100 Expert Software for the first time after installation, you first need to 
activate the different software modules with your license keys. See “How to Activate 
Software Licenses” on page 213 for details.
14 2100 Expert Software User Guide



Quick Start 2 
Running a Measurement
4 Make sure that an instrument has been detected before continuing.

5 Select an assay/method for the chip run. On the Instrument tab, click the 
Assays/Methods button.

OR

Click the Assays/Methods menu.

Both will open a menu, allowing you to select an assay/method for the 
measurement. 

6 Prepare the samples and the chip. Edit destination and data acquisition 
parameters such as number of samples, and insert sample information in 
the chip summary table. For detailed information on sample and chip 
preparation refer to:

• Kit Guides that are available for each kit (see Agilent 2100 Bioanalyzer 
Help Desk)

NOTE You can also select File > Open File to Run. This opens a dialog box allowing you to load 
either an assay/method (.xsy) or a chip data file (.xad).

NOTE When preparing chip and samples, pay attention to the essential measurement practices 
described in “Essential Measurement Practices (Electrophoretic Methods/Assays)” on 
page 61 or as described in the respective Kit Guide.
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2 Quick Start  
Running a Measurement
7 Insert the chip in the 2100 Bioanalyzer instrument:

a Open the lid.

The status of the instrument is updated on the Instrument tab.

b Check that the cartridge is inserted properly. For details, please refer to 
“Loading the Electrophoresis Chip into the 2100 Bioanalyzer 
Instrument” on page 63 .

c Place the chip into the receptacle.

Figure 1 Electrode cartridge inserted in the instrument (graphic shows an 
example).

The chip fits only one way. Do not force it into place.

CAUTION Do not force the lid closed. 
This can damage the cartridge.

➔ If the lid does not close without force, check that chip is inserted correctly. When 
the software recognizes an inserted chip, the chip is shown on the Instrument tab. 
If you have closed the lid, and the software has not recognized the chip, verify that 
the cartridge is properly installed into the instrument. Close the lid.
16 2100 Expert Software User Guide



Quick Start 2 
Running a Measurement
d Carefully close the lid.

The electrodes in the cartridge fit into the wells of the chip.

When the chip is detected, the image on the Instrument tab changes to a 
chip.

If the chip is not detected, open and close the lid again.

8 On the Instrument tab, click .

NOTE The chip that is displayed depends on the assay that was selected in the software, not on 
the actual chip that was inserted in the bioanalyzer.
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2 Quick Start  
Running a Measurement
9 Before the chip run starts, you are prompted to confirm this action with 
your electronic signature. This action is then recorded and will be available 
for reviewing in the signature log and the audit trail.

The chip run starts. The Raw Signals sub-tab shows an electropherogram of 
the currently measured sample. The name of the sample is displayed above 
the graph. The graph is a “live” plot of the migration time against 
fluorescence units (raw data, including background fluorescence, for 
example).
18 2100 Expert Software User Guide



Quick Start 2 
Running a Measurement
The number of the sample that is currently being measured is indicated on 
the information bar:

The status bar at the bottom of the window shows the measurement 
progress for the chip run and the COM port number used for data 
acquisition.

NOTE The signature must be saved with the correct setting in the Meaning field. If this setting 
cannot be pre-selected by 2100 Expert Software, you must do this selection manually.

NOTE The 2100 Expert Software Security Pack restricts access to data and functionality to users 
who are logged in with certain roles. See User Role Modelfor details (“Access Control” on 
page 39).
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2 Quick Start  
During the chip run
During the chip run

1 View the chip data file in the Data context by clicking on the name of the 
Data File.

During the chip run, you can do the following:

• Switch to any other context. For example, you can evaluate any chip data 
file in the Data context, or compare samples in the Comparison context.

• If necessary, abort the chip run by clicking on the Stop button. You need 
to confirm this action with your electronic signature.

All data that was collected up to the stop point will be saved.

2 Switch to any other context. For example, you can evaluate any chip data 
file in the Data context, or compare samples in the Comparison context.

3 If necessary, abort the chip run by clicking on the Stop button. You need to 
confirm this action with your electronic signature.

All data that was collected up to the stop point will be saved.
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Quick Start 2 
Viewing the Measurement Results
Viewing the Measurement Results

To view the results, switch to the Data context. The data file that has just been 
generated by your chip run is displayed. The Chip Summary tab shows 
information on your chip data file, and lets you modify or enter comments 
regarding chip, samples, and study.
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2 Quick Start  
Viewing the Measurement Results
1 In the tree view panel, click any sample name or the ladder.

This selects the Electropherogram tab, which displays a data plot of 
size/migration time versus fluorescence intensity.

Peaks have automatically been detected, and their characteristics such as 
size, concentration, purity, or molarity have been calculated and are shown 
in the Peak Table at the bottom of the window.
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Quick Start 2 
What You Can do When the Measurement is Finished
What You Can do When the Measurement is Finished

When the measurement is finished, you can:

• Document your chip run by entering or modifying sample names, chip 
comments, and study information, for example.

• Evaluate the measurement results by analyzing gel-like images, 
electropherograms and result flagging.

• “Analyzing and Evaluating the Results of an Electrophoretic Method or 
Assay” on page 85

• Print the results to document them on paper or an electronic format, such 
as HTML or PDF.

See “Printing Reports” on page 180.

• Export the results or parts of them for further evaluation in other 
applications.

See “Exporting Data” on page 173.

• Compare the results with the results of other chip runs in the Comparison 
context. See “Comparing Samples from Different Electrophoretic Chip 
Runs” on page 139.

• Pass the results through the predefined workflow.

See “Workflow Control” on page 50

• Insert the next chip in the 2100 Bioanalyzer instrument and start a new 
chip run.
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2 Quick Start  
What You Can do When the Measurement is Finished
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3 
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Before you start running methods/assays on the Agilent 2100 Bioanalyzer 
system, you should familiarize yourself with the 2100 Expert Software. This 
chapter shows how to get started with the 2100 Expert Software, and outlines 
its main operational possibilities.
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3 Looking at 2100 Expert Software  
Introduction to the Key Features of the 2100 Expert Software
Introduction to the Key Features of the 2100 Expert Software

The Agilent 2100 Expert Software is characterized by the following key 
features:

• 2100 Expert Software provides a single software platform with a common 
user interface for running, analyzing, evaluating, presenting, and 
comparing DNA, RNA, and protein parameters.

• 2100 Expert Software provides an optional Security Pack that needs to be 
ordered separately as G2949CA and is then activated with a license key. 
This Security Pack activates user management functions and electronic 
signature to meet the Food and Drug Administration (FDA) requirements 
(21 CFR Part 11).

• 2100 Expert Software provides detailed installation verification and system 
verification tests on the 2100 Bioanalyzer system.

• 2100 Expert Software allows having multiple chip data and/or 
method/assay files open at the same time.

• 2100 Expert Software features an data evaluation tool (Comparison context) 
allowing comparison of measurement results (of same method/assay class) 
from different chips.

• 2100 Expert Software offers the RNA Integrity Number (RIN), a reliable tool 
to automatically compare integrity of RNA samples. 

• 2100 Expert Software features improved integration including manual 
integration (available for DNA and Protein methods/assays only).

• 2100 Expert Software allows color-coded result flagging with pre-defined or 
custom result flagging rules. Flagging rules can be applied to measurement 
results.

• 2100 Expert Software has customizable result tables and gel-like images.

• 2100 Expert Software allows to control two 2100 Bioanalyzer instruments 
from one PC. It is possible to run measurements on two 2100 Bioanalyzer 
instruments at the same time.

• 2100 Expert Software has improved printing and reporting functions.

• 2100 Expert Software has extended instrument diagnostics functionality.
26 2100 Expert Software User Guide



Looking at 2100 Expert Software 3 
Starting the 2100 Expert Software
Starting the 2100 Expert Software

1 Go to your desktop and double-click the following icon:

OR

From the Windows Start menu, select All Programs > Agilent 2100 Bioanalyzer > 
2100 Expert.

2 The 2100 Environment Checker (see “The 2100 Environment Checker” on 
page 28) will validate computer settings in the background. You might have 
to acknowledge these warnings before the software will start. 

3 The access to the 2100 expert and its functionality is controlled by the 
installed Security Pack. You need to authenticate yourself with your user 
name and password.

For more information on the user management of 2100 Expert Software, 
see “The 2100 Expert Security Pack” on page 38.

The 2100 Expert Software application window appears. “2100 Expert 
Software Work Area” on page 29 gives an overview of the application 
window.
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3 Looking at 2100 Expert Software  
Starting the 2100 Expert Software
The 2100 Environment Checker
At startup of the 2100 Expert Software a few parameters, such as regional 
settings, setup of a printer and printer margins are checked automatically.

Eventually, a pop-up window will appear that indicates warnings and errors:

• Setup a default printer (“Setup a default printer” on page 198)

• Default printer margins (“Default Printer margins” on page 199)

• Configure regional settings (“Configure regional settings” on page 202)

• Display settings (“Display settings” on page 205)

• USB Configuration (“USB-to-Serial adapter configuration” on page 206)

NOTE For Security Pack users: All changes to above settings have to be performed for the 
generic 2100 System user account. Please login with this Windows user account and 
make the according changes.
28 2100 Expert Software User Guide



Looking at 2100 Expert Software 3 
2100 Expert Software Work Area
2100 Expert Software Work Area

The 2100 Expert Software has standard elements such as pull-down menus 
and toolbars, and the main working area, which contains several tabs, some of 
which have sub-tabs. The 2100 Expert Software area has the following regions 
(demonstrated at the Data context): 
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3 Looking at 2100 Expert Software  
2100 Expert Software Work Area
Operating Modes
The 2100 Expert Software can be operated in six modes, called "contexts": 

• Instrument Context

• Data Context

• Verification Context

• Comparison Context

• Method or Assay Context

• System Context

Using the Contexts bar, the Context menu, or the selection list in the toolbar, you 
can switch between the contexts:

An introduction to the six contexts is given in the following.

NOTE The contexts work independent from each other regarding their data. This means, for 
example, that you can review data and run measurements at the same time. Please note 
that in terms of the 2100 Expert Software, a method resembles an extended assay, which 
also includes additional administrative data such as operator, instrument, reporting, and 
workflow settings.

NOTE Menus, toolbars, the tree view, and the main working area (tabs) significantly change 
when you switch between the contexts.
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Looking at 2100 Expert Software 3 
2100 Expert Software Work Area
Instrument Context
On startup, 2100 Expert Software enters the Instrument context, where you can 
run DNA, RNA or protein methods/assays by selecting a method/assay file and 
starting the chip run—provided that the 2100 Bioanalyzer instrument is 
properly connected, a chip is inserted, and the lid is closed.

During the chip run(s), you can view the status of the instrument(s): 
information and real time acquisition data. 

NOTE If two 2100 Bioanalyzer instruments are connected to your PC, you can run both in parallel. 
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3 Looking at 2100 Expert Software  
2100 Expert Software Work Area
In the Instrument context, it is also possible to run hardware diagnostic tests on 
all connected instruments. Refer to “Running Instrument Diagnostics” on 
page 227 for details.

Data Context
In the Data context, you can 

• view, analyze, and evaluate the results of your chip runs that are presented 
as electropherograms, gel-like images, histograms, dot plots, and result 
tables.

• export and print the results of your chip runs.

The measurement data is stored in.xad files.
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Looking at 2100 Expert Software 3 
2100 Expert Software Work Area
Verification Context
The Verification context is used to run and document qualification tests.

For the 2100 Bioanalyzer instrument and the Expert Software, tests can be 
run for:

• Installation Verification

• System Verification

Verification results are automatically saved in .xvd files. You can re-open .xvd 
files to review verification results.

For details, refer to “Performing Verifications” on page 233.
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3 Looking at 2100 Expert Software  
2100 Expert Software Work Area
Comparison Context
In the Comparison context, you can open multiple electrophoretic chip data 
files and compare samples of the same assay class (DNA 1000, for example). It 
is possible to overlay electropherograms and compare the results. 

Comparison results can be saved in .xac files. You can re-open .xac files to 
review the comparison results and to add further samples for comparison.
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Looking at 2100 Expert Software 3 
2100 Expert Software Work Area
Method/Assay Context
In the Method/Assay context, you can create your own methods/assays based 
on Agilent templates by modifying certain data (e. g. data analysis setpoints, 
sample names or result flagging). Within a method/assay, you also define 
general settings, which include the instrument(s) to be used, the relevant 
study, the workflow to be followed, and the reporting elements.

Methods/Assays are stored as .xsy files.
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3 Looking at 2100 Expert Software  
2100 Expert Software Work Area
System Context
In the System context, you can

• define System Wide Settings for the 2100 Expert Software such as settings for 
default file names and directories, signal colors, auto export functions, or 
default export directories 

• view the contents of the System Log Book

• add or delete users and assign the required roles to the users (available to 
administrators only)

• make use of the import/export and archiving functions (available to 
administrators and backup operators only)
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Looking at 2100 Expert Software 3 
Closing 2100 Expert Software
Closing 2100 Expert Software

1 From the File menu, select Exit.

If a chip run is in progress, the following message appears:

2 Click OK and wait until the chip run is complete.

3 If the currently open file has not yet been saved, 2100 Expert Software asks 
for your electronic signature in order to save the file.

After you have confirmed the messages, 2100 Expert Software quits.

NOTE This dialog box may also appear if you try to switch between contexts while there is 
unsaved data.

HINT When opening a saved data file later, you can always load earlier versions of the file if 
required.
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3 Looking at 2100 Expert Software  
The 2100 Expert Security Pack
The 2100 Expert Security Pack

The 2100 Expert Software with the Security Pack license provides 
functionality for

• Access Control (“Access Control” on page 39)

• Data Integrity (“Data Integrity” on page 42)

• Handling of Electronic Signatures (“How to Sign your Work Steps” on 
page 43)

• Workflow Control (“Workflow Control” on page 50)

With access control functionality, only authenticated and authorized users can 
access and modify data, i.e. any electronic record created or managed by 2100 
Expert Security Pack. It is part of the concept to guarantee the security and 
integrity of all analytical data created with the 2100 Bioanalyzer instrument 
and managed by the 2100 Expert Software on a validated PC system. This data 
security protects all raw data, methods/assays, and results from unauthorized 
access. Together with the functionality provided for handling of electronic 
signatures and workflow managment, the security pack renders the 2100 
Expert Software compliant to the regulations and guidelines of the Food and 
Drug Administration (FDA) for electronic records and electronic signature, 21 
CFR Part 11.

With the workflow management functions, only dedicated users can perform 
measurements and create result data. This data must then be reviewed in a 
way that is configurable, but always requires a 4-eyes principle in order to 
approve results. The review levels are configurable regarding to who will be 
allowed to perform them, but also regarding to how many levels of reviews 
have to be accomplished for a certain method/assay.
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Looking at 2100 Expert Software 3 
The 2100 Expert Security Pack
Access Control
The 2100 Expert Security Pack provides configurable access control and user 
management functionality to ensure that only authorized users can access the 
software and the measurement data:

• User control (login, access to functionality and data)

Each user must log on to the 2100 Expert Software by entering his/her user 
name and password. Access to data as well as to functions is only permitted 
to authenticated and authorized users according to their user roles. Each 
user is identified and checked for his or her function at all times.

Some program settings (configuration) are specially protected and can only 
be edited by the 2100 Expert administrators.

• Application lock

If the 2100 Expert Software workplace is not used within a specified 
amount of time, the screen is automatically locked. In such cases, only 
authorized users can unlock the computer. During a method workflow, only 
the current user or a special unlock operator can remove the application 
lock.

• Windows user accounts

2100 Expert Software deploys and integrates windows operating system 
technology for the configuration of user and password management. Thus, 
options of configuration are versatile and also pre-existing configurations 
can be easily applied to 2100 Expert Software.

User Role Model
The 2100 Expert user role model ensures that every user is allowed to access 
only those functions he/she is authorized to use (functional security).

User Account
The 2100 Administrator takes care of the 2100 Expert Software user accounts. 
To work with the 2100 Expert Software, you have to log on first (password 
protected).
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3 Looking at 2100 Expert Software  
The 2100 Expert Security Pack
Roles and Access Rights
Depending on your tasks, you are assigned to one or several user roles, for 
example, administrator, operator, or advanced operator. Rights that are 
associated with your roles provide access to specific functions of the 2100 
Expert Software.

By default, the following roles are used within the 2100 Expert Software:

• 2100 Administrator

Is responsible for user accounts and roles. Additionally, can perform data 
export and archiving and can open methods/assays and data files. The 2100 
Administrator also has rights to access the secured area with the Windows 
Explorer for backup and archiving purposes.

• Backup Operator

Is responsible for batchwise export and import, archiving and dearchiving, 
and backup possibilities with external tools. The backup operator also has 
rights to access the secured area with the Windows Explorer for backup 
and archiving purposes.

• Standard Operator

Can create and run methods/assays and analyze the data, cannot change 
advanced setpoints nor perform manual integration.

• Advanced Operator

Can create and run methods/assays and analyze the data, including 
changing the advanced setpoints and performing manual integration. Can 
additionally validate instruments.

• Validation Operator

Is responsible for validating the 2100 Bioanalyzer system, usually an 
Agilent service engineer.

• 2100 Unlock Operator

Is needed in case of a private lock applied or if another user needs access 
and the user corresponding to the private lock unexpectedly is not 
available.

• 2100 Guest

Merely has got read-only access to methods/assays and data, but no 
operating functionality.
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In most cases 2100 Expert Software displays all data for reviewing 
independent of the user role. However, only that functionality is available that 
is associated with the specific role. Note that a user may have more than one 
role assigned.

If you have several roles and need to perform a task associated with a role 
other than your current role, you have to log out and log back in with the other 
role.

Table 2 More specifically, the users with the different roles have access to the following functions
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System User management X
Archive/de-archive data X X
Import/export multiple files X X X

Verif. Verify system and instruments X X
Method/
Assay

Open method/assay files X X X X X X X

Create and modify methods/assays 
(except advanced setpoints and result 
flagging rules)

X X

Modify advanced setpoints and result 
flagging rules

X

Instr. Run methods/assays on instruments X X
Data Open data files X X X X X X X

Analyze measurement data (except 
advanced setpoints and manual 
integration)

X X

Modify advanced setpoints and use 
manual integration

X

General Read log books X X X X X X X
Change password X X X X X X
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Data Integrity
2100 Expert Software provides functionality to ensure the integrity of all data:

• Data protection

The measurement data is stored in the restricted area of the file system. It 
cannot be accessed with the Windows Explorer by ordinary means. This 
means that viewing files and data with the Windows operating system 
explorer is restricted.

• Audit trails and log books

User actions in the 2100 Expert Software are logged in so-called audit trails 
and signature logs. These are records of access-controlled actions and 
cannot be manually modified. They are subject to data protection and are 
saved within the data files or with the 2100 Expert system file. 

The audit trails and signature logs capture the following actions:

• Service access and all administration activities

• Changes to access rights of users

• Modifications to measurement data

• The logins and logouts of users, as well as failed attempts to log in and 
opening and closing of sessions

• Additional concepts are provided for 

• Version control to identify original files and to control versioning of file 
copies

• Archiving functionality and data access for backup purposes for 
particular users

• Disaster recovery
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Handling of Electronic Signatures
All activities such as creating or modifying data must be confirmed by the user 
with his or her electronic signature to proof their authentication. 

To ensure data security, no user can sign two consecutive steps in the 
workflow. If, for example, one user executes a measurement, another user has 
to review and approve the results.

The different levels of the review workflow are completed by signing them. 
Once a user has performed a step (for example, reviewed the results), he/she 
has to sign it. The data is then released for the next workflow level. Then the 
next user is responsible for the method and the previous user can no longer 
reject the step. He/she would have to inform the next user to reject the results. 

The complete sequence of steps is documented in the audit trail and the 
signature log, even if the desired result was not achieved.

How to Sign your Work Steps
You have performed an action that requires to be signed with your electronic 
signature such as creating or modifying data.

To sign your work within 2100 Expert Software:
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1 If you choose to save the current data or if you try to switch to another file 
or context, 2100 Expert Software asks for your signature: 
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2 At the top of this dialog, you see the list of changes. Click the plus symbol to 
expand the sections of the list.

3 The Meaning field is used to state the main purpose of your modifications. 
In some cases, however, the meaning is unequivocal and you don’t need to 
select it here. This is, for example, when starting a chip run. Then the 
meaning is already preselected and cannot be changed. 

4 To specify your intention in more detail, use the Comment field.

5 Enter your User ID (login name) and your Password in the Signature section. 
Furthermore, the displayed Domain name must be correct. This is either the 
local PC name or the network domain, depending where your User ID is 
defined.

6 To finish the electronic signature, click OK.
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How to Approve/Reject the Current Workflow Level
With every method, an appropriate workflow must be defined in order to 
release it for use. This means that one or several users must be explicitly 
specified to approve the work of each workflow level. When executing a 
method, these users can then approve the measured results and move the 
method to the next workflow level.

To approve the current workflow level:

1 To review the results, switch to the Data context.

As the analyst who was running the method, you now can check the 
measured results of all samples. 

2 Samples can be approved from the Chip Summary tab table (also in a bulk), or 
individually in the Electropherogram tab.

a In the Approved column of the sample table, specify for each sample 
whether the results can be approved or must be rejected.
46 2100 Expert Software User Guide



Looking at 2100 Expert Software 3 
The 2100 Expert Security Pack
b Right-click on the sample's electropherogram and select your Approval for 
the sample.

3 If all samples are approved, you select Approve current workflow from the 
Workflow menu.

4 Confirm your changes to the state of the samples with your electronic 
signature.
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5 Additionally, confirm the workflow level approvement with your workflow 
signature.

The method is moved to the next workflow level (review).

Only the users that are specified in the method for this level are authorized 
to do the review. The number of required review levels is also specified in 
the method. 

If you are reviewing the method in a later workflow level and the results are 
not as required, you can also reject the method by selecting Reject current 
workflow from the Workflow menu. The method must then be taken care of 
the users of the previous level again.
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If you are assigned to two subsequent workflow levels, you cannot approve 
both levels. When trying to approve the second subsequent level, the 
following message appears:

The user doing the final review finalizes the method by approving the final 
workflow level. However, he/she has the option to revoke this finalization in 
case errors are observed afterwards. This can also be done from the 
Workflow menu.
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Workflow Control
All measurements follow a determined workflow. This workflow includes 
steps such as the execution of methods, peer reviews, and the final approval. 
The workflow also defines that only pre-defined users in certain roles can take 
these actions and that any other user is restricted from doing so. Every action 
in the workflow must be signed by the user with an electronic signature, 
before it can be passed on to the next review/workflow level. The workflow 
management in particular provides means of reproducibility and traceability 
for the measurements, thus providing data and result reliability. 

For every measurement done with the 2100 Bioanalyzer system, the following 
workflow must be followed:
1 Method/Assay setup

Methods/Assays are created from method/assay templates and can be 
modified as required for a particular measurement, typically done by an 
advanced operator.

2 Method execution
The available methods are used to run measurements. This includes the 
following steps:
• Preparing the required samples, reagents, chip and the instrument
• Entering the required administrative information in the method
• Executing the method
The methods are typically executed by a standard operator.

3 Analyst review(s)
Every measurement must be evaluated by one of the analyst reviewers. The 
reviewer decides whether the measurement gets approved (moved to the 
next workflow level) or rejected (moved one workflow level back).

4 One or more peer reviews and approval (depending on your system 
configuration)
Some labs require the approval of several reviewers. The number of 
required reviews can be specified in the method.

5 Final review
With the evaluation of the final reviewer, the measurement is finished, in 
case the evaluation results in an approval.

6 Exception route
Revoke of the final approval brings back the file into the state, where one of 
the final reviewers can modify the file and do a changed approval in case of 
a sample or a setpoint had been accidentally set in a wrong manner and 
needs to be adjusted before the final state of the document.

This workflow is valid for all methods and measurements and can only be 
operated in this exact order.
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This chapter explains how electrophoretic measurements are made using the 
2100 Bioanalyzer system, gives detailed descriptions of all steps necessary to 
run electrophoretic assays, and shows how to analyze and evaluate results 
using electropherograms and gel-like images.
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Principles of Nucleic Acid and Protein Analysis on a Chip

The electrophoretic methods/assays are based on traditional gel 
electrophoresis principles that have been transferred to a chip format. The 
chip format dramatically reduces separation time as well as sample and 
reagent consumption. The system provides automated sizing and 
quantification in a digital format. On-chip gel electrophoresis is performed for 
the analysis of DNA, RNA and proteins.

The chip accommodates wells for samples, gel and an external standard 
(ladder). Micro-channels are fabricated in glass to create interconnected 
networks among these wells. During chip preparation, the micro-channels are 
filled with a sieving polymer. Once the wells and channels are filled, the chip 
becomes an integrated electrical circuit. The 16-pin electrodes of the cartridge 
are arranged so that they fit into the wells of the chip. Each electrode is 
connected to an independent power supply that provides maximum control 
and flexibility. Charged biomolecules like DNA, RNA, or protein/LDS micelles 
are electrophoretically driven by a voltage gradient—similar to slab gel 
electrophoresis. Because of a constant mass-to-charge ratio and the presence 
of a sieving polymer matrix, the molecules are separated by size. Smaller 
molecules are migrating faster than larger ones. The detection is based on 
laser-induced fluorescence detection (LIF). Dye molecules intercalate into 
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DNA or RNA strands or protein/LDS micelles. For some applications proteins, 
RNA or DNA are covalently labeled with a fluorescent dye before separation. 
The detection is automatically performed by laser induced fluorescence (LIF) 
detection. Data is translated into gel-like images (bands) and 
electropherograms (peaks). With the help of a ladder that contains 
components of known sizes, a standard curve of migration time versus 
molecule size is plotted. From the migration times measured for each molecule 
in the sample, the size is calculated. Depending on the assay, one or two 
internal markers are run with each of the samples. The markers are internal 
standards used to align the ladder data with data from the sample. This is 
necessary to compensate for drift effects that may occur during the course of a 
chip run. 

For all DNA methods/assays, quantitation is done with the help of the upper 
marker. The area under the upper marker peak is compared with the sample 
peak areas. Because the concentration of the upper marker is known, the 
concentration for each sample can be calculated. The same principle for 
quantification based on the upper marker is also used for the Protein 80 and 
230 assays. The quantification of the High Sensitivity Protein 250 assay is 
based on the external ladder. The area under the ladder is compared with the 
sum of the sample peak areas. Besides this relative quantification, an absolute 
quantification is available for all protein methods/assays, using standard 
proteins.

For RNA methods/assays, quantification is also done based on the ladder as 
described above. In addition, for total RNA methods, the ribosomal ratio is 
determined, giving an indication on the integrity of the RNA sample. 
Additionally, the RNA integrity number (RIN) can be utilized to estimate the 
integrity of total RNA samples based on the entire electrophoretic trace of the 
RNA sample, including the presence or absence of degradation products. 

The 2100 Expert Software plots fluorescence intensity versus size/migration 
time and produces an electropherogram for each sample:
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The data can also be displayed as a densitometry plot, creating a gel-like 
image:
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Preparing and Running an Electrophoretic Method or Assay

An electrophoretic chip run requires the following steps:

1 Switch on the 2100 Bioanalyzer instrument and start the 2100 Expert 
Software. Details are given in “Starting the 2100 Expert Software” on 
page 27

2 Select an electrophoretic method/assay.

See “Selecting an Electrophoretic Method” on page 58.

3 Prepare reagents, chip, and samples.

See “Preparing Samples, Reagents, and Chips for Electrophoretic 
Methods/Assays” on page 61 and the appropriate Kit Guide.

4 Load the chip into the instrument.

For details refer to “Loading the Electrophoresis Chip into the 2100 
Bioanalyzer Instrument” on page 63.

5 Start the chip run.

See “Running an Electrophoretic Method or Assay” on page 68.

6 When the chip run has finished, you can:

• Have a first look at the results (see “Displaying the Measurement Results 
(Electrophoresis)” on page 75). 

• Document the chip run (see “Entering Chip and Sample Information” on 
page 73). 

• Analyze and evaluate the results:

• See “Displaying the Measurement Results (Electrophoresis)” on 
page 75.

• See “Result Flagging” on page 145.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model for details (“Access Control” on 
page 39).

NOTE Please note that in terms of the 2100 Expert Software, a method resembles an extended 
assay, which also includes additional administrative data such as operator, instrument, 
reporting, and workflow settings. 
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Selecting an Electrophoretic Method

To select a method/assay:

1 Switch to the Instrument context.

2 In the Tree View Panel, select the instrument you want to use.

In the upper left of the Instrument tab, an icon shows the status of the 
instrument. You should see one of the following icons (lid open/closed), 
indicating that the 2100 Bioanalyzer instrument is detected by the system:

3 If you do not see one of these icons, check that the 2100 Bioanalyzer 
instrument is switched on and properly connected:

• Check the COM port setting.

• Make sure the instrument is physically connected to the PC (over the 
serial interface or the USB-serial adapter).

• Check the power connection.

• Check the power switch.

If you need additional help, please refer to the Agilent 2100 Bioanalyzer 
System Maintenance and Troubleshooting Guide.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model ( “Access Control” on page 39) for 
details.
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4 Select a method/assay for the chip run.

a On the Instrument tab, click the Methods/Assays button.

OR

Click the Methods/Assays menu.

OR

Select File > Open File to Run. This opens a dialog box, allowing you to load 
either a method/assay (.xsy) or a chip data file (.xad).

Both will open the Methods/Assays menu, allowing you to select a 
method/assay from the submenus.

The type of method/assay you have to select depends on the required 
measurement and the kit you use to prepare your samples. Details on 
these methods/assays are described in the Kit Guide.

5 Select the desired method/assay, DNA 1000, for example.

The method/assay is loaded and its name appears on the Information Bar:

NOTE After a chip run, the results can be evaluated using parameters from a different 
electrophoretic chip data file (.xad) of the same method/assay type (DNA 1000 in this 
example). Refer to “Importing Data Analysis Setpoint” on page 170.

NOTE The chip data file (.xad) that will be generated as the result of the chip run will be stored 
the indicated Destination folder in the Secured Area.
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6 Specify an appropriate Destination and File Prefix for this file.

The total number of samples that can be measured varies with the type of 
method/assay selected.

NOTE With DNA and RNA Nano assays, 12 samples may be run; with RNA Pico assays, 11 
samples may be run; and with Protein assays, the maximum number of samples is 10. 
When preparing the chip (see “Preparing Samples, Reagents, and Chips for 
Electrophoretic Methods/Assays” on page 61), keep in mind that you have to follow the 
sequence of the sample wells.

When preparing the chip, keep in mind that you have to follow the sequence of the sample 
wells. For example, if you want to measure only 3 samples, you have to fill the wells 1, 2 
and 3 of your chip.
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Preparing Samples, Reagents, and Chips for Electrophoretic Methods/Assays
Before you can load a chip, you have to prepare the samples and reagents. To 
find out how to prepare the samples and reagents, refer to the various Kit 
Guides available for each Kit. Please refer to these documents for further 
information and analytical specifications.

In general, preparing an electrophoretic method/assay involves the following 
steps:
• Check that you have everything that is listed in the appropriate Kit Guide. 

Be aware that there can be small but important differences between the 
different methods/assays even for the same type of molecules (for example, 
between DNA 1000 and DNA 7500 methods/assays).

• Make sure you are familiar with the essential measurement practices (see 
below next page).

• Before running the first RNA method/assay: decontaminate the electrodes.
• Prepare all the reagent mixtures (for example, the gel-dye mix).
• Load the gel or the gel-dye mix using the priming station.
• Load the DNA/RNA marker solution and buffer.
• Load the destaining solution for protein methods/assays.
• Load the chip with ladder and samples.

Essential Measurement Practices (Electrophoretic Methods/Assays)

WARNING Toxic and hazardous reagents and samples
They may harm your health.

➔ Wear hand and eye protection and follow good laboratory practices.

➔ Prepare and handle reagents and samples with care.

WARNING Handling dye/DMSO reagent
Kit components contain DMSO. Because the dye binds to nucleic acids, it should be 
treated as a potential mutagen and used with appropriate care. 

➔ Wear hand and eye protection and follow good laboratory practices when preparing 
and handling reagents and samples.

➔ Handle the DMSO stock solutions with particular caution as DMSO is known to 
facilitate the entry of organic molecules into tissues. 
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General:
• Handle and store all reagents according to the instructions given in the Kit 

Guides.
• Avoid sources of dust or other contaminants. Foreign matter in reagents 

and samples or in the wells of the chip will interfere with method/assay 
results.

• Always insert the pipette tip to the bottom of the well when dispensing the 
liquid. Placing the pipette at the edge of the well may lead to poor results.

• Protect all reagents from light. Remove light covers only when pipetting. 
The dye contained in the reagents decomposes when exposed to light and 
this reduces signal intensity.

• Use a new syringe and electrode cleaner with each new Kit.
• Do not touch the 2100 Bioanalyzer instrument during a chip run and never 

place it on a vibrating surface.
• Allow all reagents and samples to equilibrate to room temperature for 30 

minutes before use.
• Use loaded chips within 5 minutes. Reagents might evaporate, leading to 

poor results. 
• Keep all reagents and reagent mixes refrigerated at 4°C when not in use.

RNA Methods/Assays:
• Always wear gloves when handling RNA, and use RNase-free tips, microfuge 

tubes and water.
• Thaw RNA samples on ice.
• It is recommended to heat denature all RNA samples and RNA ladder before 

use (70°C, 2 minutes) and keep them on ice.
• To prevent contamination problems, it is strongly recommended to use a 

dedicated electrode cartridge for RNA methods/assays. Perform the RNAse 
decontamination procedure for the electrodes on a daily basis before 
running any methods/assays.

• Always vortex the dye concentrate for 10 seconds before preparing the 
gel-dye mix and spin down afterwards.
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Protein Methods/Assays:

• Upon arrival make aliquots of the sample buffer and ladder with the typical 
amount required for the daily use and store them at -20°C. Keep the vial in 
use at 4°C to avoid freeze-thaw cycles.

• Use 0.5 mL vials to denature samples. Using larger vials may lead to poor 
results, caused by evaporation.

Loading the Electrophoresis Chip into the 2100 Bioanalyzer 
Instrument

For electrophoretic measurements, the electrode cartridge is required.

The electrode cartridge contains 16 electrodes that fit into the wells of DNA, 
RNA, and protein chips. Each electrode in the cartridge has an individual 
power supply. All electrophoretic methods/assays (DNA, RNA, and protein) 
require an electrode cartridge. The electrode cartridges will either have an 
engraved “1” at the front, or will have no engraving at all. Cartridges with a 
different number are not electrode cartridges.
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Loading Procedures

If you want to change the electrode cartridge
If you want to change the electrode cartridge, proceed as follows:

1 Open the lid and pull down the metal locking lever in the open position as 
shown in the following figure.

The cartridge is pushed out.

2 Gently pull the cartridge out of the lid.

NOTE Store the electrode cartridge in the provided box.
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3 Slide the new electrode cartridge into the lid as shown below.

4 Push the metal front of the cartridge to ensure a tight connection.

5 Push the metal locking lever into the flat (closed) position.

CAUTION Do not touch the electrodes while the cartridge is in the 2100 Bioanalyzer instrument.
The electrodes and the high voltage power supplies can be damaged.

➔ Be careful with the electrodes and the high voltage power supplies.

➔ Do not touch the electrodes while the cartridge is in the 2100 Bioanalyzer 
Instrument.
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To load the prepared chip into the 2100 Bioanalyzer instrument:
1 Open the lid and remove any chip.

2 Place the prepared chip into the receptacle. 

The chip fits only one way. Do not force it into place.

Figure 2 Electrode cartridge inserted in the instrument (graphic shows an 
example).

3 Carefully close the lid.

When the chip is detected, the image on the Instrument tab changes to a chip.

CAUTION Do not force the lid closed. 
This can damage the cartridge.

➔ If the lid does not close without force, check that the cartridge and chip are 
inserted properly.

➔ When the software recognizes an inserted chip, the chip is shown on the 
Instrument tab. If you have closed the lid, and the software has not recognized the 
chip, verify that the cartridge is properly installed into the instrument. Close the lid.
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If the chip is not detected, open and close the lid again.

NOTE The displayed image depends on the method/assay selected in the software, not the type 
of chip inserted. If you would like to run a DNA chip but a protein chip appears, you have 
selected the wrong method/assay.

NOTE If the AutoRun option is active, the chip run starts automatically once a chip has been 
inserted and the lid has been closed.
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Running an Electrophoretic Method or Assay

NOTE You can stop a chip run at any time, for example, if errors occurred or if you are not 
satisfied with the quality of the measurement results that you can observe during the chip 
run. See “Stopping a Chip Run” on page 72.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model (“Access Control” on page 39) for 
details.
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Starting and Stopping an Electrophoretic Chip Run

Starting a Chip Run
When you have loaded the chip, you can start the chip run:

1 On the Instrument tab, click 

2 To start the chip run, you need to confirm this action with your electronic 
signature, which will be recorded in the audit trail.
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The chip run starts. The Raw Signals sub-tab shows an electropherogram of 
the currently measured sample. The name of the sample is displayed above 
the graph. The graph is a “live” plot of the migration time against 
fluorescence units (raw data, including background fluorescence, for 
example).

The number of the sample that is currently being measured is indicated on 
the information bar:

The status bar at the bottom of the screen shows the measurement progress 
for the chip run and the COM port number used for data acquisition.
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3 During the chip run, you can do the following:

• View the chip data file in the Data context e.g. clicking on the name of the 
Data File:

• Switch to any other context. For example, you can evaluate any chip data 
file in the Data context, or compare samples in the Comparison context.

• If necessary, abort the chip run by clicking on the Stop button. You need 
to confirm this action with your electronic signature.

All data that was collected up to the stop point will be saved.

4 After the chip run is completed, you can:

• Switch to the Data context, where you can view, analyze, and evaluate the 
results of your chip run (see “Displaying the Measurement Results 
(Electrophoresis)” on page 75 and “Analyzing and Evaluating the Results 
of an Electrophoretic Method or Assay” on page 85).

• Stay in the Instrument context and start a new method/assay, for example.
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Stopping a Chip Run
You can stop a chip run at any time, for example,

• if the quality of the measurement results does not meet your expectations,

• if, for example, after three samples you already have the information you 
desired and you want to start another chip run.

To stop the method/assay:

1 Click the  button. 

OR

From the Instrument menu, select Stop.

b Click Yes to stop the chip run.

NOTE You cannot resume a stopped chip run.

NOTE If you stop a chip run, automatic export (see “Exporting Chip Run Data Automatically” on 
page 176) and automatic print (see “How to Turn on and Configure Automatic Printing of 
Chip Run Reports” on page 185) does not take place.

The following message appears:

NOTE Data acquisition of the current sample will be aborted.
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2 When the chip run is aborted, you can:

• Switch to the Data context, where you can view, analyze, and evaluate the 
results (if any) of your chip run (see “Displaying the Measurement 
Results (Electrophoresis)” on page 75 and “Analyzing and Evaluating the 
Results of an Electrophoretic Method or Assay” on page 85).

• Stay in the Instrument context, where you can start the next chip run.

Entering Chip and Sample Information

Before and after a chip run, you can document the run by entering 
information on chip and samples.

1 In the Data context, select the Chip Summary tab.

2 On the Sample Information sub-tab, you can enter or modify additional 
information such as sample names and comments. On the Study Information 
sub-tab, you can enter information such as the name of the current study, 
the laboratory location, and the experimenter, for example.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model (“Access Control” on page 39) for 
details.
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For details on all input fields, refer to Chip Summary tab.

3 From the File menu, select Save.

NOTE You may find some input fields already filled in, because chip, sample, and study 
information are taken over from the base method/assay or chip data file or sample 
information was already entered in the Instrument context. 

HINT You can import chip, sample, and study information from .txt or .csv files. This is especially 
helpful and time-saving, if you already have documented a similar chip run in another chip 
data file. Refer to “Importing Chip and Sample Information” on page 171 for details.
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Displaying the Measurement Results (Electrophoresis)

You can view the measurement results of an electrophoretic chip run as 
electropherograms or gel-like images. 
• You can display the electropherograms either one sample at a time, or all 

samples at the same time to get an overview of the chip run, for example, to 
see the progress of a reaction. See “How to Switch Between Single View and 
Grid View” on page 75.

• You can navigate through the samples. See “How to Navigate Through the 
Samples” on page 76.

• You can change the display of electropherograms and gel-like images to 
make details better visible. See “How to Change the Display of 
Electropherograms and Gel-like Images” on page 77.

How to Switch Between Single View and Grid View
To switch between single view and grid view:
1 From the Electropherogram menu, select View Single Sample or View All Samples.

OR

Click the View Single Sample  or View All Samples  button on the 
Electropherogram toolbar.
OR
Click the All Samples entry in the Tree View Panel to switch to the grid view, 
or any sample name to switch to the single view.
OR
Double-click any electropherogram in the grid view to switch to single view:

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model (“Access Control” on page 39) for details.
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How to Navigate Through the Samples
At any time—even during a chip run—you can scroll though all samples—either 
in electropherogram or gel view.

Navigation Procedures

To navigate through samples using the Lower Panel:
1 If the lower panel is not visible, select View > Lower panel. 

The lower panel appears in the lower left corner.

2 Electropherogram view: Click any lane of the small gel image.

OR

Gel view: Click any well on the chip icon.

To navigate through samples using the TreeView Panel:
1 If the tree view is not visible, select View > Tree View. 

The tree view panel appears to the left of the tabs, and shows all chip data 
and method/assay files as nodes. 

2 Click any sample name.

Electropherogram view: the electropherogram of the selected sample is shown 
in single view

Gel view: the lane of the gel-like image corresponding to the selected sample 
is highlighted.

To browse through samples:
1 From the Electropherogram or Gel menu, select Next Sample or Previous Sample.

OR

Click the Next Sample  or Previous Sample  button in the electropherogram 
or gel toolbar.

To switch between electropherogram and gel view
1 Click the Electropherogram or Gel tab to display the results of the selected 

sample as an electropherogram or as a gel-like image.
76 2100 Expert Software User Guide



Running and Evaluating Electrophoretic Methods/Assays 4 
Preparing and Running an Electrophoretic Method or Assay
How to Change the Display of Electropherograms and Gel-like Images
It is possible to change the display of electropherograms and gel-like images.

In electropherograms and gel-like images you can:

• zoom (enlarge or reduce using the mouse) the graphs to display details, for 
example.

In electropherograms, you can additionally:

• change the peak labeling, e.g. peak size

• switch the x-axis description between size and migration time

• switch enhanced RNA view on and off

• show data points.

• pan and scale the graph using the mouse.

• change the background from a gray-to-white gradient to white.

• add a grid to the electropherograms.

In gel-like images, you can additionally:

• change the exposure

• change the gel color.

• change order of gel lanes in gel like images.
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How to change the display

 How to zoom into an electropherogram 
1 From the Electropherogram menu, select Graph Mode > Zoom (default setting). 

2 Position the mouse pointer in the electropherogram.

3 Click and hold down the left mouse button.

The mouse pointer changes its shape to a magnifying glass:

4 Drag the mouse. 

A rectangle shows the part of the an electropherogram to be enlarged.

5 Release the mouse button.

 How to pan and scale an electropherogram 
1 From the Electropherogram menu, select Graph Mode > Pan or Scale. 

2 Position the mouse pointer in the electropherogram.

3 Click and hold down the left mouse button.

The mouse pointer changes its shape to a double-arrow or to a double 
crosshair.

4 Drag the mouse. 

As you drag the mouse, the electropherogram curve moves in the drag 
direction (Pan mode), or the scales of the X and/or Y axes change (Scale 
mode).
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5 Release the mouse button.

a You can perform several zoom, pan and scale steps in a row.

b To undo the last zoom, pan, or scale step: Click the Undo Zoom  button 
or double-click in the electropherogram.

c To undo all zoom, pan, and scale steps: Click the Undo All  button.

d To remove the gray-to-white gradient from the background of an 
electropherogram: From the Electropherogram menu, select Show Gradient.

The color gradient disappears and a white background is displayed.

e To show/hide the grid lines on an electropherogram: From the 
Electropherogram menu, select Show Grid.

 How to undo the last zoom, pan, or scale step 

1 Click the Undo Zoom  button or double-click in the electropherogram.

 How to undo all zoom, pan, and scale steps 

1 Click the Undo All  button: 

NOTE You can perform several zoom, pan and scale steps in a row.
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 How to display data points in an electropherogram: 

1 From the Electropherogram menu, select Show Data Points or click the  
button in the toolbar.

Data points used to generate the graph are now shown as bullets. Data 
points are 0.05 seconds apart.

 How to change the peak labeling or remove the labeling: 

1 Click on the  dropdown menus in the toolbar.

 How to switch the x-axis between size or migration time: 

1 Click on the  button in the toolbar.

 How to switch the enhanced RNA view on and off: 

1 Click on the  button in the toolbar.

The greyscale of the gel image is recalculated while excluding the marker 
peak intensity. This will enhance band visibility for faint samples with low 
fluorescence intensity.
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 How to remove the gray-to-white gradient from the background of an 
electropherogram 
1 From the Electropherogram menu, select Show Gradient.

The color gradient disappears and a white background is displayed.

 How to show/hide the grid lines on an electropherogram 
1 From the Electropherogram menu, select Show Grid.

 How to zoom into a gel-like image: 
1 Position the mouse pointer in the gel.

2 Click and hold down the left mouse button.

The mouse pointer changes its shape to a magnifying glass  and a 
horizontal line appears.

A second horizontal line appears showing the part of the gel to be enlarged.

3 Release the mouse button.

 You can perform several zoom steps in a row. 
To undo the last zoom step:

1 Click the Undo Zoom button  or

OR

double-click in the gel.

To undo all zoom steps:

1 Click the Undo All button .
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 How to change the order of the gel lanes: 
1 Position the mouse pointer on top of a gel lane.

The mouse pointer changes its shape to a hand.

2 Click and hold down the left mouse button.

3 Drag the mouse left or right.

The mouse pointer changes its shape to a pointing hand and a vertical line 
appears.

4 Release the mouse button.

The lane is inserted in the new position.

 How to switch between displaying sizes or migration time [sec]: 
1 Select Gel > Show Sizes or

OR

click on the Show Sizes button  in the toolbar.

 How to change the exposure of the gel: 
1 Move the exposure slider right to the gel up and down to change the 

"exposure" of the gel.

 How to change the gel color: 
1 Select Gel > Gel Color or

OR

click on the Gel Color button  in the toolbar and select a color scheme 
from the list.
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Cleaning the Electrodes
When the method/assay is complete, remove the used chip from the 
instrument and dispose of it according to the guidelines established by your 
laboratory safety officer. Remove the chip quickly to prevent a buildup of 
residues from the solutions on the electrodes.

Then perform the cleaning procedure to ensure that the electrodes are clean 
(i.e., no residues left from the previous method/assay). The cleaning 
procedures are described in detail in the appropriate Kit Guide and in the 
Agilent 2100 Bioanalyzer System Maintenance and Troubleshooting Guide.
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Good Practices

1 Empty and refill the electrode cleaner at regular intervals (e.g., every five 
methods/assays).

The electrode cleaner can be used for 25 methods/assays.

CAUTION Electronic Discharge
Electrostatic discharge could damage the high-voltage power supplies.

➔ Always use the electrode cleaner for cleaning the electrodes.

➔ Never use a cloth to clean the electrodes.

CAUTION Damage of power supply by wet electrodes 
Wet electrodes can cause severe damage to the on-board high voltage power 
supplies.

➔ Always make sure the electrodes are dry before inserting them into the 2100 
Bioanalyzer instrument again.
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Analyzing and Evaluating the Results of an Electrophoretic 
Method or Assay

The purpose of electrophoretic methods/assays is to separate sample 
components and determine their size, concentration, purity, or molarity. 
Results for a particular sample are calculated after all data for that sample has 
been read.

The steps in data analysis differ depending on the type of method/assay in 
use:

• “Data Analysis: DNA” on page 86

• “Data Analysis: RNA and CY5-labeled Nucleic Acids” on page 89

• “The RNA Integrity Number (RIN)” on page 91

• “The data analysis process for protein methods/assays consists of the 
following steps:” on page 100

• “Smear Analysis” on page 106

Further steps in analysis are:

• “Changing the Data Analysis” on page 110

• “Manual Integration” on page 129

• “Reanalyzing a Chip Data File” on page 138

• “Comparing Samples from Different Electrophoretic Chip Runs” on 
page 139

• “How to Use the Form Mode” on page 148

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model (“Access Control” on page 39) for 
details.
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Data Analysis: DNA
1 Raw data is read and stored by the system for all individual samples.

2 The data is filtered and the resulting electropherograms are plotted. You 
can change the settings of the data analysis after the run and reanalyze 
your data.

3 Peaks are identified and tabulated by peak ID. You can change the settings 
of the peak find algorithm and reanalyze the data after the run has finished. 
(Note that peak find settings can be changed for all or only certain 
samples.)

4 A sizing ladder (see the following example electropherogram), which is a 
mixture of DNA fragments of known sizes, is run first from the ladder well. 
The concentrations (ng/μL) and sizes (bp) of the individual fragments are 
preset in the method/assay and cannot be changed.

5 A standard curve of migration time versus DNA fragment size is plotted 
from the DNA sizing ladder by interpolation between the individual data 
86 2100 Expert Software User Guide



Running and Evaluating Electrophoretic Methods/Assays 4 
Analyzing and Evaluating the Results of an Electrophoretic Method or Assay
points. The standard curve derived from the data of the ladder well should 
resemble the one shown below.

6 Two DNA fragments, the lower and upper marker, are run with each of the 
samples, bracketing the DNA sizing range. The markers are internal 
standards used to align the ladder data with data from the sample wells. 
The figure below shows an example of assigned marker peaks in a sample 
well.

NOTE The software performs alignment by default. Turning automatic data analysis off suspends 
data analysis until you turn it on again.
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7 The standard curve, in conjunction with the internal markers, is used to 
calculate DNA fragment sizes for each sample from the migration times 
measured.

8 To calculate the concentration of the individual DNA fragments in all 
samples, the upper marker, in conjunction with a method/assay-specific 
concentration against base-pair size calibration curve, is applied to the 
individual sample peaks in all sample wells.

9 If the check box Rest. Digest on the Chip Summary Tab is enabled, the 
2100 Expert Software flags peaks that may have co-migrated:

Since it is assumed that the molarity of all the fragments in a restriction 
digest should be the same, any peaks or clusters having a molarity that is 
significantly larger than the rest are flagged as potentially co-migrating 
peaks, allowing you to examine them in more detail.

NOTE The software allows you to redefine the peaks chosen as upper and lower markers. A 
change in marker selection will cause quantitative changes in the calibration procedure, 
and therefore in the entire data evaluation.
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Data Analysis: RNA and CY5-labeled Nucleic Acids
1 Raw data is read and stored by the system for all individual samples.

2 The data is filtered and the resulting electropherograms are plotted. You 
can change the settings of the data analysis after the run and reanalyze 
your data.

3 Peaks are identified and tabulated by peak ID. Fragments, such as 
ribosomal RNA, are also tabulated. You can change the settings of the peak 
find algorithm for any or all samples and reanalyze the data.

4 An RNA ladder (containing a mixture of RNA of known concentration) is 
run first (see the electropherogram below). The amount and individual 
sizes are preset in the assay and cannot be changed.

Electropherogram of RNA Nano 6000 Ladder 

5 The lower marker is run as internal standard with each of the samples and 
is used to align the ladder with the samples.

NOTE Peak ratios for the RNA ladder may vary from one batch of RNA 6000 ladder to the next. 
Method/assay performance will not be affected by this variation.
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6 For the Eukaryote or Prokaryote Total RNA, the ribosomal RNA fragments 
(either 18S and 28S for eukaryotic RNA or 16S and 23S for prokaryotic 
RNA) are detected and displayed in the Fragment Table sub-tab. After 
detection, the ratio of the fragment areas is calculated and displayed in the 
Results sub-tab.

7 For the mRNA method/assay, the ribosomal RNA, if present, is detected and 
displayed in the Fragment Table sub-tab. The ribosomal RNA 
contamination is calculated and displayed in the Results sub-tab.

8 The RNA integrity number is automatically determined and displayed in the 
Results sub-tab and below the gel-like image.

9 To calculate the concentration of the RNA, the area under the entire RNA 
electropherogram is determined. The ladder, which provides the 
concentration/area ratio, is applied to transform the area values into 
concentration values.

10 For the small RNA small and miRNA regions are determined and average 
size, size distribution, concentration and % of total are displayed in the 
Region Table sub-tab.

11 For the Small RNA method/assay, the small RNA and miRNA concentration 
and the miRNA/small RNA ratio [%] is calculated and displayed in the 
Results sub-tab.
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Alignment of RNA Samples
The marker  solution that is part of each RNA kit, contains a 50 bp DNA 
fragment. This fragment is used as lower marker to align all samples.
By default the RNA alignment and the subtraction of the lower marker are 
enabled for RNA Nano methods/assays.
The marker is displayed as the first peak in the electropherogram.

The RNA Integrity Number (RIN)
The RNA integrity number (RIN) is a tool designed to help scientists estimate 
the integrity of total RNA samples. The RIN extension automatically assigns an 
integrity number to a eukaryote total RNA sample analyzed on the 2100 
Bioanalyzer system. Using this tool, sample integrity is no longer determined 
by the ratio of the ribosomal bands alone, but by the entire electrophoretic 
trace of the RNA sample, including the presence or absence of degradation 
products. In this way, interpretation of an electropherogram is facilitated, 
comparison of samples is enabled and repeatability of experiments is ensured.

Scope
What the RIN can do:
• Obtain an assessment of the integrity of RNA.
• Directly compare RNA samples (e.g. before and after shipment, compare 

integrity of same tissue across different labs, etc.).
• Ensure repeatability of experiments (e.g. if RIN shows a given value and is 

suitable for microarray experiments, then the RIN of the same value can 
always be used for microarray experiments given that the same 
organism/tissue/extraction method/assay was used).

What it cannot do:
• Tell a scientist ahead of time whether an experiment will work or not if no 

prior verification was done (e.g. RIN of 5 might not work for microarray 
experiments, but might work well for an appropriate RT-PCR experiment. 
Also, an RIN that might be good for a 3' amplification might not work for a 5' 
amplification).

The computation of the RIN is part of data analysis for total RNA samples. The 
computed RNA integrity number is shown on the Results sub-tab of the Gel or 
Electropherogram tab of the Data context. It is also included in XML export files 
and in printed reports.
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Although the lower quantitative limit of the RNA 6000 Nano method/assay is 
specified as 25 ng/μL it is recommended to use at least 50 ng/μL for a 
meaningful RNA integrity number. When using lower concentrations, higher 
sample to sample variances of the RIN may be observed.

NOTE Until now, the computation of the RIN has only been validated for eukaryote total RNA 
Nano samples. The 2100 Expert Software also calculates the RIN for prokaryote and plant 
total RNA samples and for the RNA 6000 Pico method/assay. Be aware that for these 
samples, the RIN has not been validated in extensive downstream experiments.
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Examples for RNA Integrity Numbers
A database of about 1300 mammalian total RNA samples was created using 
the RNA 6000 Nano method/assay. The samples came from different species 
(mainly human, rat and mouse), tissues, preparation methods/assays, 
concentrations and degradation states. All samples were classified according 
to their degradation state. Numbers from 1 to 10 were used as labels. 10 
stands for a perfect RNA sample without any degradation products, whereas 1 
marks a completely degraded sample. The labels in-between are used to 
indicate progressing degradation states of the RNA sample. The following 
figure shows typical representatives for each of the 10 RNA integrity classes.
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Computation of the RNA Integrity Number
For the computation or the RNA integrity number, the electropherogram is 
partitioned into regions as shown in the figure below. The lower marker and 
the 18S and 28S fragments divide the electropherogram into nine regions:

Signal Anomalies
In addition to the computation of the RIN, the data analysis detects various 
unexpected signals, disturbing the computation of the RIN. Such disturbances 
are called anomalies. Region anomaly detectors recognize unexpected signals 
in each region. If detected, the anomaly is displayed in the Error sub-tab of the 
Electropherogram and Gel tab. 

Anomaly Description Critical?
Unexpected baseline signal Yes
Unexpected signal in pre-region No
Unexpected signal in 5S-region Yes
Unexpected signal in fast-region Yes
Unexpected signal in inter-region Yes
Unexpected signal in precursor-region No
Unexpected signal in post-region No
Unexpected ribosomal ratio Yes
Unexpected sample type Yes
Unexpected lower marker (compared to previous well) No
2100 Expert Software User Guide 95



4 Running and Evaluating Electrophoretic Methods/Assays  
Analyzing and Evaluating the Results of an Electrophoretic Method or Assay
Two categories of anomalies were introduced, critical and non-critical. 
Anomalies in regions interfering with the customer sample RNA are 
considered critical. The corresponding gel lane is flagged red. 

The baseline anomaly, for example, is detected for signals with fluctuating or 
steep baseline. The ribosomal ratio anomaly detects unexpected ratios of the 
28S fragment area and the 18S fragment area. The unexpected sample type 
anomaly is detected for samples which do not fit the standard total RNA 
profile. 

If a non-critical anomaly is detected, the RIN can still be computed accurately. 
Therefore non-critical anomalies are not flagged. Non-critical region 
anomalies are pre-region anomaly, precursor-region anomaly and post-region 
anomaly. The electropherogram below gives an example for a non-critical 
anomaly in the post-region.
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To take full advantage of the RIN feature, a 2 step use-model is 
suggested:
1 Determine the threshold value for the RIN that results in meaningful 

downstream experiments:

Correlate RIN with downstream experiment and determine threshold RIN 
for meaningful results (iterative process)

2 Run standard experiment and use RIN to determine if sample integrity is 
sufficient:
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Troubleshooting the RIN
To obtain meaningful and reproducible results, the lower marker must be 
identified correctly. On details on how to adjust the lower marker, please refer 
to “Changing the Data Analysis” on page 110.

In rare cases, the RIN value for a sample might not be shown in the Results tab 
but marked as “not available” (N/A). Such results are typically related to 
unexpected signals and thus critical anomalies, see “Signal Anomalies” on 
page 95.

The root cause should be investigated by checking:

• Is the correct assay selected for this experimental run?

• Is the marker correctly assigned by the software?

• Are the ribosomal fragments correctly assigned by the software?

• Are the samples correctly treated and heat-denatured?

Details about the critical signal anomaly are shown in the Errors tab, see 
Figure  on page 99.

If critical anomalies have been detected during the analysis, in many cases RIN 
values can still be displayed by increasing the thresholds. The user can modify 
predefined thresholds for anomaly detection. The higher the threshold the less 
anomalies are detected. Valid threshold values range from 0 to 1.

How to create your own assay file with adapted anomaly thresholds by default 
is described in “How to modify a custom assay method” on page 165. A 
customized assay will not change the RIN value, which is calculated by an 
independent algorithm.

RNA Integrity Number Setpoints
Various setpoints are available to customize the display of the RIN (RNA 
Integrity Number). With these setpoints, you can modify the predefined 
thresholds for anomaly detection. You can find them in the advanced user 
mode of the setpoint explorer.

NOTE “RIN N/A“ is a warning that the RIN may not be reliable for a particular sample (such as 
due to unusual noise/signals, ribosomal ratio, and other factors). Clearing the critical error 
message may yield a RIN, but Agilent does not guarantee the accuracy of this value. It is 
recommended to also perform a visual inspection of the data.
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To adjust the setpoints for a single sample, switch to the Local tab of the 
setpoint explorer and open the RNA Integrity Number group.

To adjust the setpoints for the whole chip, switch to the Global tab of the 
setpoint explorer and open the RNA Integrity Number group in the Sample 
Setpoints group. For the chip, you can additionally switch between integer and 
decimal representation of the RIN.

For more information on how to use the setpoint explorer, see About the 
Setpoint Explorer ( “Changing the Data Analysis” on page 110).
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Data Analysis: Protein

The data analysis process for protein methods/assays consists of the 
following steps:
1 Raw data is read and stored by the system for all samples.
2 The data is filtered and the resulting electropherograms are plotted. You can 

change the settings of the data analysis after the run and reanalyze your data.
3 Peaks are identified and tabulated by peak ID. You can change the settings of 

the peak find algorithm and reanalyze the data after the run has finished. (Note 
that peak find settings can be changed for all or only certain samples.)

4 A sizing ladder (see the example electropherogram below), which is a mixture 
of proteins of different known sizes, is run first from the ladder well. The sizes 
of the individual proteins are preset as kDa in the method and cannot be 
changed. Please note that the individual protein concentrations may vary 
slightly from ladder lot to ladder lot.
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5 A standard curve of migration time versus size is plotted from the sizing 
ladder by interpolation between the individual protein size/migration 
points. The standard curve derived from the data of the ladder well should 
resemble the one shown below.
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6 Depending on the protein method/assay, one or two internal marker 
proteins are run with each of the samples. The “lower marker” and/or 
“upper marker” proteins are used to align the ladder data with data from 
the samples. The figure below shows an example of assigned marker peaks 
in a sample well.

7 The standard curve, in conjunction with the markers, is used to calculate 
protein sizes for each sample from the migration times measured.

NOTE The software performs alignment by default. Turning automatic data analysis off suspends 
analysis until you turn it on again.
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8 To calculate the concentration of the individual proteins in all samples of 
the Protein 80 or the Protein 230 assay, the upper marker with known 
concentration is used. The concentration is calculated based on the time 
corrected area underneath each sample peak and the upper marker in the 
same sample. The protein concentration of the High Sensitivity Protein 250 
assay is determined similar to the RNA methods/assays. The relative 
protein concentration is determined based on the area measuered 
underneath the individual sample peak and the area measured for the 
ladder on the same chip. For all protein methods/assays it is possible to 
perform absolute quantification (See “Absolute Protein Quantitation” on 
page 103).

9 In addition to the concentration of the individual proteins, which is listed 
in the Peak Table, the total relative protein concentration (ng/μL) is 
determined as displayed in the Results sub-tab.

10 The purity (in % total) is calulated for the individual protein of each sample 
based on the ration to the total protein concentration.

Absolute Protein Quantitation
Absolute quantification is calculated based on the relative concentration of a 
sample and user-defined standards and the known concentration of this 
standards. 

For protein samples you can enable the use of calibration for each sample and 
enter the concentration of the standard protein. This allows you to generate a 
calibration curve, which is used to analyze and quantitate this protein within 
different samples on the same chip. The generated standard curve can also be 
used to quantitate any other sample protein relative to the standard protein.

NOTE The software allows you to define the markers yourself. A change in the selection of the 
markers will lead to quantitative changes in the calibration procedure, and therefore in the 
entire data evaluation.
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Using Calibration in Protein Assays 
The calibration feature for protein assays allows quantification based on 
external standard calibration. 

On the Chip Summary tab, use the sample table on the Sample Information sub-tab 
to define the samples that you want to use as calibration standards by clicking 
the checkmark box Use for Calibration and enter a concentration.
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The calibration standard should be run at least in three different 
concentrations to generate a calibration curve. The software will 
automatically produce this calibration curve to determine the actual 
concentration of the corresponding protein in all other samples within the 
same chip. In the peak tables of the samples, a remark is added to the 
observation column to identify the calibration protein and the calibrated 
proteins:

The calibration curve can be displayed by switching to the Calibration Curve 
sub-tab on the Chip Summary tab. 
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Smear Analysis
The 2100 Expert Software allows to perform a smear analysis for all 
electrophoresis methods/assays. 

When the smear analysis is enabled (in the advanced setpoints), the software 
allows you to define regions of interest. These regions are used to define the 
area of broad peaks and determine their part of the total area. Smear analysis 
provide a means to analyze broad signals that can be hardly evaluated with the 
normal peak assignment. 

You therefore can define regions that contain the peaks of interest. The 
regions are defined by size, e.g. base pairs or kDa. For these regions you can 
determine the region area in relation to the total area.

Enabling and Performing Smear Analysis

To enable smear analysis:
1 Go to the Electropherogram tab in the Data context

2 Go to the Setpoint Explorer and select the Local or Global tab, depending on 
which samples should be analyzed.

3 Select the Advanced mode from the dropdown menu.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model (“Access Control” on page 39) for 
details.
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4 Under Smear Analysis, select the check box Perform Smear Analysis.

The Region Table sub-tab is added to the Electropherogram tab.
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Performing Smear Analysis
After enabling the smear analysis in the setpoint explorer, you are able to 
insert regions of interest in the electropherogram. 

To do so:

1 Select the Region Table sub-tab in the Electropherogram tab.

2 Right-click the electropherogram and select Add region.

A region will be inserted into the electropherogram. The Region Table shows 
the values for the inserted region.

3 Repeat the previous step until the number of required regions is inserted. 

4 Adjust the regions by directly moving the dashed lines in the 
electropherogram.

5 To remove a region, right-click the dashed line in the electropherogram and 
select Remove Region from the context menu.

NOTE The smear analysis table can be directly edited by selecting the region table under Smear 
Analysis in the setpoint explorer. It can also be opened when right clicking on the table in 
the Region Table sub-tab or in the electropherogram. In the region table it is possible to 
define the regions by entering upper and lower limits.
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In the smear region table, you can edit the Region Start Size and Region End 
Size, for example:
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Changing the Data Analysis

Different sets of parameters (data analysis setpoints) can be changed in the 
software in order to modify the data evaluation for sample analysis:

• Filtering parameters

• Peak find parameters for all samples/peak height for individual samples

• Enabling smear analysis

• Align to upper and/or lower marker

• Adding/deleting ribosomal fragments (for RNA assays/methods only)

• Manual integration (for protein and DNA assays/methods only)

• Absolute quantification (for protein assays/methods only)

These settings can be made before a new run is started or when reanalyzing a 
previously saved data file.

About the Setpoint Explorer
The tool allowing you to modify the data analysis setpoints is the Setpoint 
Explorer. The Setpoint Explorer is accessible from:

• Assay Properties Tab

• Electropherogram Tab (Single/Grid View)

• Gel Tab

On the Assay Properties tab, the Setpoint Explorer is always visible and lets you 
modify setpoints globally (for all samples):

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model ( “Access Control” on page 39) for 
details.
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If the Setpoint Explorer is not visable on the Electropherogram/Gel tab, click 
the vertical bar on the right edge of the application window:

The Setpoint Explorer appears.

For electrophoretic assays/methods, you can modify the setpoints

• globally, that is, for all samples (Global tab)

• locally, for the current sample (Local tab)

Setpoints can be modified in a normal mode (normal user) and advanced mode 
(experienced user). Click the + nodes to expand, and the – nodes to collapse 
branches. Setpoints that you can change are white. To edit a setpoint, 
double-click the value, enter the new value, and press enter. The changes are 
applied automatically.

NOTE On the Assay Properties tab the Local tab can be enabled by clicking on the individual 
sample in the Tree View panel.
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When you try to change any global setpoints where local settings have been 
applied, the software prompts you as to whether you want to overwrite the 
local (custom) settings.

If you decide to overwrite the custom sample settings, all local settings you 
made will be discarded. If you decide not to overwrite the custom sample 
settings, the global settings will not be applied where local settings have been 
changed.

Changing setpoints requires that you confirm the action with your electronic 
signature.
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Color Coding of Setpoint Values
Specific color coding indicates differences between local setpoint values and 
global setpoint values. The following differences are indicated:

• One local setpoint value differs from the global setpoint value as defined for 
this assay. On the Local tab, a yellow background indicates that a local 
setpoint value has been modified and differs from the current global 
setpoint value.

A tooltip displays the global value defined for this assay.

Right-click the local setpoint value to access the following functions:

Copy to Clipboard: The currently loaded local setpoint values are copied to the 
clipboard as flat table.

Restore Default: The local setpoint value is reset to the setpoint value as 
currently defined on the Global tab.

Set as Default: The local setpoint value is set as new global setpoint value, but 
not automatically applied to all other samples.

On the Global tab, the corresponding global setpoint value for which a local 
setpoint value has been modified is displayed in blue font color.
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A tooltip displays the corresponding local values of all samples in 
sequential order.

• Local setpoint values differ from the global values as preset by Agilent but 
match the global setpoints as currently defined for this assay.

On the Global tab, a yellow background indicates that the global setpoint 
value differs from the value as preset by Agilent but all local setpoints have 
the same value as the current global value.
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A tooltip displays the global value as preset by Agilent. 

• Local setpoint values differ from the global values as preset by Agilent as 
well as from the global setpoints as currently defined for this assay.

On the Global tab, a blue font color on yellow background indicates that the 
global setpoint value differs from the global setpoint values as preset by 
Agilent and at least one local setpoint value.
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Right-click the global setpoint value to access the following functions:

Copy to Clipboard: The currently loaded global setpoint values are copied to 
the clipboard as flat table.

Apply to All: The current global setpoint will be applied to all samples and 
override their current value.

Restore Default: The current global setpoint will be reset to default as preset 
by Agilent, but will not override current local setpoint values.
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Filtering Setpoints
The first step the software takes in analyzing the raw data is to apply data 
filtering. The following filtering setpoints can be changed in the advanced 
mode under Filter Settings:

Filter Width [s]: Defines the data window, given in seconds, used for averaging. 
The broader the filterwidth, the more raw data points are used 
for averaging. As a result, the noiselevel will decrease, but peaks 
will become lower and broader. Overall, changing the Filter Width 
has more effect on the result of the filtering procedure applied 
then does changing the Polynomial Order.

Polynomial Order: This setting isused to define the power series applied to fit the 
raw data. The higher the number, the more the fit function will 
follow the noisy raw data curve. As a result, the noise level of 
the filtered curve will increase.
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Integrator Setpoints
After data filtering, the peak find algorithm locates the peaks and calculates 
the local peak baselines. The algorithm begins by finding all the peaks above 
the noise threshold in order to determine the baseline, after which any peaks 
below the noise threshold are rejected. A local baseline is calculated for each 
peak to allow for baseline drift.

Setpoints can be modified in a "normal" mode (normal user) and "advanced" 
mode (experienced user).

The integrator setpoints that can be changed are:

Slope Threshold: The Slope Threshold setpoint determines the difference in the 
slope that must occur in order for a peak to begin. The inverse of 
this value is used to determine the peak end.

Area Threshold: The Area Threshold determines the minimum amount of peak 
area that must be detected before a peak is recognized.

Height Threshold [FU]: The Height Threshold setpoint determines whether a peak is 
kept. It represents the minimal peak height. For each peak, the 
difference between the start point value and the center point 
value (local baseline) must be greater than the Height Threshold 
value.

Width Threshold [s] The Width Threshold determines whether a peak is kept. It 
represents the minimal peak width. For each peak, the difference 
between the start and end point (local peak baseline) must be 
greater than the Width Threshold value. 

Peak Filter Width [s]: The Peak Filter Width setpoint determines the minimum amount 
of time that must elapse before a peak is recognized.

Baseline Plateau [s]: The Baseline Plateau setpoint is a parameter that assists in 
finding peaks. The signal is recognized to be at baseline 
whenever the slope of the data is less than the Slope Threshold 
setpoint (either positive or negative) for longer than the time set 
for the Baseline Plateau. This setting rejects brief, low slope 
areas such as between non-baseline-resolved peaks.

Peak Filter Polynom The Peak Filter Polynom setpoint defines the order of the 
polynom which is used to filter the data to find peaks. The larger 
this whole number value is the more sensitive is the filter and 
the more peaks get detected. The peak filter polynom is directly 
linked to the peak filter width. The entered value multiplied by 
0.05 (data rate) must be less or equal the peak filter width.
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List of setpoints that can be changed
General Assay Setpoints

• Electrophoresis Properties 

• Gel Color: Select gel color from dropdown menu

• Ladder Concentration

Ladder and/or Sample Setpoints

• Baseline Calculation

• Zero Baseline (on/off): Zero signal to baseline

• Flat Baseline (on/off): If selected, baseline level will be equal to start 
baseline level.

• Filter Settings

• Filter Width [s]: Defines the data window used for averaging.

• Polynomial Order: Defines the power series applied to fit the raw data.

• Baseline Correction 

• Perform Baseline Correction (on/off)

• Integrator 

• Slope Threshold

• Area Threshold

• Height Threshold [FU]

• Width Threshold [s]

• Baseline Plateau [s]

• Peak Filter Width [s]

• Peak Filter Polynom

• Calibration 

• Calibrate All ( on/off)

• Smear Analysis 

• Perform Smear Analysis (on/off)

• Regions Table

• RNA Fragment 

• Fragment Detection Table: Structure to provide molecular fragment type.

• Use Dynamic Time Window (on/off): Use dynamic window for detection 
of ribosoms.
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• RNA Integrity Number 

• Pre Region Anomaly Threshold: Sensitivity for detection of signal 
anomalies before lower marker.

• 5S Region Anomaly Threshold: Sensitivity for detection of signal 
anomalies between lower marker and the fast region.

• Fast Region Anomaly Threshold: Sensitivity for detection of signal 
anomalies between 5S region and 18S.

• Inter Region Anomaly Threshold: Sensitivity for detection of signal 
anomalies between 18S and 28S fragments.

• Precursor Region Anomaly Threshold: Sensitivity for detection of signal 
anomalies between 28S fragment and post region.

• Post Region Anomaly Threshold: Sensitivity for detection of signal 
anomalies after precursor region.

• Baseline Anomaly Threshold: Sensitivity for detection baseline signal 
anomalies.

• Ribosomal Anomaly Threshold: Sensitivity for detection of unexpected 
ribosomal RNA ratios.

• Unknown Sample Type Threshold: Sensitivity for detection of unknown 
sample types.

• Marker Anomaly Threshold: Sensitivity for detection of marker 
anomalies.

• Single Decimal Represe. (on/off): Show the RIN as integer or with one 
decimal place.

• Threshold Prerequisite: Threshold for minimum total RNA concentration 
to show RIN.
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Manually Moving Fragment Start and End Points (RNA and Cy5-Labeled 
Nucleic Acids)
It is possible to alter the integration start and end points manually for 
individual fragments in an RNA or Cy5-labeled nucleic acids assay/method. 
The integration borders of detected RNA-fragments are displayed in the 
Fragment Table sub-tab. Zooming in on the base of a particular fragment allows 
you to see the start and end points. Placing the cursor over one of these points 
changes the cursor to a pointing hand, allowing you to click and drag the point 
along the line of the fragment until it is positioned as desired.

Move any other start or end points as desired. This is only required if the 
automated integration needs some adjustment.
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HINT The fragment table can be directly edited in the setpoint explorer in the advanced mode, 
RNA Fragment > Fragment Detection Table:

NOTE Changing the start or end points of the fragment will change the calculated rRNA ratio and 
rRNA concentration. The calculated RNA Integrity Number (RIN) is not affected.

It might be convenient to pause the automatic analysis (Electropherogram > Pause 
Automatic Analysis) until all changes are done.
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Setting the Baseline for Calculation of RNA Concentration
At low signal-to-noise ratios, the baseline that defines the area used for 
calculating the concentration of RNA assays/methods is highly dependent on 
the settings for the Start and End Time. You can adjust the Start and End 
Times manually (thereby adjusting the baseline) to ensure a good result even 
at very low signal-to-noise ratios. Choose a single sample in the 
Electropherogram Tab, Results Sub-tab. Two vertical green long-dashed lines 
indicating the setpoints for the Start and End Times (with the baseline drawn 
between them) are displayed in the window.

Move the cursor over the long-dashed line on the left (Start Time setting) and 
drag the line to the desired position. Do the same with the long-dashed line on 
the right (End Time setting) until you have a flat baseline.

NOTE Changing the start or end points of the fragment will change the calculated rRNA 
concentration and rRNA ratio. The calculated RNA Integrity Number (RIN) is not affected.

It might be convenient to pause the automatic analysis (Electropherogram > Pause 
Automatic Analysis) until all changes are done.
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Assigning Upper and Lower Marker Peaks (all electrophoretic assays)
For each sample, the upper and/or lower marker peaks are assigned first and 
then the data is aligned so that the sample markers match the ladder markers 
in time, allowing the size and concentration of the sample peaks to be 
determined.

The first peak is assigned to be the lower marker and is then offset to match 
the lower marker in the ladder. The upper marker, if present, is then assigned 
to the last peak in the sample or to the peak nearest the ladder’s upper 
marker.

If you get unexpected peaks in the ladder analysis, unexpected sizing results 
or find that the markers have been set incorrectly, you may exclude peaks 
manually from the ladder or set a peak to be used as a marker. Right-clicking 
in the peak table causes a context menu to appear, allowing you to do so:

In case the 2100 Expert Software did not detect the markers in the samples 
correctly, you are able to manually assign them in the same way.

NOTE Excluding a peak or manually setting a peak to be an upper or lower marker may cause 
errors during analysis.
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Aligning or Unaligning the Marker Peaks
The upper and lower are aligned to the ladder markers by resampling the 
sample data in a linear stretch or compression using a point-to-point fit.

Data before alignment:

Markers aligned to the ladder:
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If the sample marker peaks are either more than twice as far apart or less than 
half as far apart as the ladder markers, they are assumed to be the wrong 
peaks, and analysis of the sample stops, producing the error “Marker peaks 
not detected”.
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NOTE With DNA and protein assays/methods, the height of marker peaks is assay/method 
dependent. Ladder peaks are analyzed to calculate a marker peak threshold that is used to 
locate the marker peaks in the sample wells. If the marker peaks found using this 
calculated assay/method fail to align with those of a sample, the 2100 Expert Software 
will use the minimum peak height threshold setting instead (if this value is lower than the 
value for the marker peak). For example, the calculated threshold might be too high to find 
the sample's markers if they happen to be very small for some reason. Either no markers 
will be found or the wrong peaks will be assumed to be markers and these may not align 
with the ladder markers. Consequently, the software attempts to use the minimum peak 
height threshold that, if it is set low enough, will catch the real markers, allowing the 
sample to align.

NOTE After alignment, peaks are shown with relative migration times that are different from the 
real migration times with data unaligned.
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Manual Integration
For DNA and Protein assays/methods, the 2100 Expert Software allows to 
manually integrate peaks. This is only required if the integration results do 
not reflect the expectations. Manual integration allows you to move, add or 
delete peak baselines. 

Examples for Manual Integration

Example: Adjusting peak baselines
To manually change peak baselines:

1 Switch to the Electropherogram tab in the Data context and zoom into the 
electropherogram to enlarge the peak of interest.

2 Select Electropherogram > Manual Integration to switch on the manual 
integration. 

OR

As an alternative you can click the Manual Integration button  in the 
toolbar.

The baseline points become visible as blue or green dots. Highlighted 
baseline points are labelled green and can be moved either along the 
vertical line (press CTRL key and left mouse button) or along the signal 
trace (left mouse button). The blue baseline points are fixed and cannot be 
moved. To highlight a baseline point, click it.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model (“Access Control” on page 39) for 
details.

HINT To move a peak baseline, point along the vertical line, press the CTRL key and left mouse 
button. To move a peak baseline, point along the signal, press the left mouse button only.
2100 Expert Software User Guide 129



4 Running and Evaluating Electrophoretic Methods/Assays  
Analyzing and Evaluating the Results of an Electrophoretic Method or Assay
3 If you want to change several baseline points, deactivate the automatic 
analysis by clicking the Pause Analysis button in the toolbar.

This way, the software will not recalculate the data analysis with every 
change.

Once you have changed all baseline points, click the Pause Analysis button 

 again to activate automatic analysis.
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4 Adjust the baseline points as appropriate.

• To move a peak baseline point along the signal or the vertical dotted line, 
press the left mouse button.

• If the new peak baseline point is not on the signal trace, create a new 
dotted vertical line by press the CTRL key and the left mouse button and 
move the point along this line.

5 Click the Automatic Analysis button  to enable the integration again. 

The integration results in the result and peak tables will change according 
to the changes done.

HINT To move a peak baseline point along the vertical line, press the CTRL key and the left 
mouse button. To move a peak baseline point along the signal, press the left mouse button 
only.
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Example: Removing peaks
To remove peaks in the Manual Integration Mode:

1 Switch to the Electropherogram tab in the Data context and zoom into the 
electropherogram to enlarge the peak of interest.
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2 Select Electropherogram > Manual Integration to switch off the automatic 
integration. As an alternative you might click the Manual Integration button 

 in the toolbar.

The baseline points become visible as blue or green dots.
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3 Right-click a baseline-point and select Remove Peak from the context menu. 

The two baseline points and the connecting line will disappear and the 
integration results shown in the result and peak tables will be updated:
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Example: Inserting peak baselines
To insert peaks in the Manual Integration Mode:

1 Highlight the Electropherogram tab in the Data context and zoom into the 
electropherogram to enlarge the peak of interest.
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2 Right-click the electropherogram and select Add Peak from the context 
menu.
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3 Two baseline points and the connecting line will appear and the integration 
results shown in the result and peak tables will be updated.

4 Adjust the baseline points as described in “Example: Adjusting peak 
baselines” on page 129.
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Reanalyzing a Chip Data File

To do this:
1 To open a chip data file (.xad), click File > Open.

2 Choose the filename from the list of data files.

3 Click OK.

The items that can be changed for reanalysis are:
• All assay setpoints see “Changing the Data Analysis” on page 110,

• sample and study information,

• marker peak assignment,

• manual integration see “Manual Integration” on page 129,

• result flagging see “Result Flagging” on page 145,

• quantification.

If you save the data file after making changes, it will keep a record of the 
changes such as gel color, sample names, and peak find settings that were in 
effect at the time the file is resaved. If you do not want to change the original 
file, choose File > Save As… and give the file a new name or save it to a different 
location.

NOTE Occasionally you may wish to open and view or reanalyze a chip data file that was run and 
saved previously. The raw data values are saved in the data file, along with the analysis 
settings that were chosen for the run, so that the data can be reanalyzed with different 
settings.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model ( “Access Control” on page 39) for 
details.

HINT When applying modified data analysis setpoints, performing manual integration or 
changing the RNA fragment analysis, the software will (by default) immediately 
recalculate the raw data, which takes some time. Select Don’t Analyze from the Gel Menu 
or Electropherogram Menu to temporarily switch off automatic data analysis while you 
modify setpoints.
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Comparing Samples from Different Electrophoretic Chip Runs
The 2100 Expert Software allows you to compare the measurement results of 
samples from different electrophoretic chip runs. Samples to be compared 
must be from chip runs of the same method/assay type. 

In the Comparison context, you can create comparison files, include samples 
from different chip runs, and compare the samples by overlaying 
electropherograms, for example. 

To compare samples from different electrophoretic chip runs:

1 Switch to the Comparison context.

2 From the File menu select Open, and open all chip data files (.xad) that 
contain the samples you want to compare.

The .xad files appear in the Select Data Files list of the Tree View Panel.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See for detail User Role Model (“Access Control” on page 39)

NOTE The Select Data Files list also contains all electrophoretic .xad files that are currently open 
in the Data context.
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3 Select a .xad file from the Select Data Files list to display a list of its samples.

4 Right-click a sample name and select Add Sample to New Comparison File.

You need to confirm this action with your electronic signature.

A new comparison file appears in the upper part of the tree view containing 
the sample. The sample is selected and its electropherogram is shown.

HINT Double-clicking a sample name in the lower part of the tree view or dragging a sample 
name into the tree view adds the sample to the comparison file that is currently selected 
in the upper part of the tree view. Or, if no comparison file is selected, creates a new 
comparison file and adds the sample to it.
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Note that the Electropherogram Tab (Single/Grid View) has the same 
functionality as in the Data context.
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5 You can now add further samples from any of the open .xad files to the 
comparison file.

You are notified if you try to add a sample of a .xad file that has the wrong 
method/assay type.

6 To remove samples from a comparison file, right-click the sample name and 
select Delete Sample from Comparison File.

You need to confirm this action with your electronic signature.
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7 To compare the electropherograms of samples, go to the Electropherogram 
tab, click Overlaid Samples in the toolbar and select the samples to be 
compared.
2100 Expert Software User Guide 143



4 Running and Evaluating Electrophoretic Methods/Assays  
Analyzing and Evaluating the Results of an Electrophoretic Method or Assay
8 Select the Gel tab to display a comparison of the gel-like images of the 
samples.

Note that the Gel tab has the same functionality as in the Data context.

9 From the File menu, select Save to save the comparison file (.xac) under the 
default name, or select Save As to save it under a new name.

The default name is derived from the method/assay class: 
“ComparisonFileX [Method Class].xac” where “X” is an autoincremented 
number. Example: “ComparisonFile0 Protein 230.xac”

You need to confirm this action with your electronic signature.

NOTE You can re-open comparison files to review the comparison results, and to add/remove 
samples.
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Result Flagging

Result flagging can be used to assign a user-defined color codeto a sample. 
This lets you easily identify samples with certain properties immediately after 
a chip run, e.g. all total RNA samples with RIN above 7.5 are marked in green.

The color assignment is carried out by applying a sequence of rules to the 
measurement results obtained for the sample. The rules are defined on chip 
level and are applied to all samples of the chip. 

Two modes are available to define result flagging rules: 

• Form Mode 

In this mode, you can choose an application specific result flagging rule 
from a given list. Additional attributes, such as size or concentration are 
entered in the preset forms.

• Editor Mode

This mode is more flexible and allows you to write arbitrary complex 
expressions by using functions, variables and operators.

Regardless of how you create the result flagging rules, there are two options 
available for the order in which the rules are applied:

• In Normal mode, the rules are applied in the given order, and the first 
matching rule will determine the color of the sample. All rules are applied 
subsequently. The first rule which applies to the sample defines its color. So 
you should start with the most specific rule. If that one does not apply, a 
less specific one may apply. If none of the defined rules apply, the final 
default rule defines the color code.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. 

See User Role Model ( “Access Control” on page 39) for details.

HINT You can export and import result flagging rules from other method/assay or chip data files. 
See “Exporting Result Flagging Rules” on page 179 and “Importing Result Flagging 
Rules” on page 172.
2100 Expert Software User Guide 145



4 Running and Evaluating Electrophoretic Methods/Assays  
Result Flagging
• In Target mode, all rules are applied subsequently. If the next rule applies, 
the color code changes to the color code defined by the rule, otherwise the 
previous color code is kept. Therefore, the last matching rule defines the 
color code of the sample. This mode is called target mode because later 
rules refine the result color code. The first default color code is the most 
general and the last one the most specific.

You can switch between the Normal or Target mode using the Result Flagging 

menu or the or button in the toolbar. You can define the flagging rules 
already in the method, or—after the chip run is finished—modify these rules or 
define new rules in the chip data file, and apply the rules to the measurement 
results. Defined rules can also be saved, loaded and applied to other data files.

HINT The examples shown in this chapter are taken from the demo method/assay “Demo 
Protein 230 Series II.xsy”, that comes with the 2100 Expert Software. You can find this 
demo method/assay in the “..\methods\demo\electrophoresis” subdirectory of the 2100 
Expert Software installation folder. In the “..\data\samples\resultflagging” subdirectory of 
the 2100 Expert Software installation folder, you can find further examples for result 
flagging rules (.xml), which you can import in the “Protein 230 Series II” demo 
method/assay.
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Defining Result Flagging Rules
The rules can be defined on the Result Flagging tab. This tab is available in the 
Data context if an electrophoretic chip data (.xad.) file is selected and in the 
Assay context if an electrophoretic assay (.xsy) file is selected.
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How to Use the Form Mode
The Form Mode provides some pre-defined rules (forms) that you can use to 
define the result flagging rules to colorcode your samples. You can set up any 
number of rules for evaluation. As a typical example of how these forms are 
used, you can flag DNA samples that have a fragment purity of 10% for 
fragment sizes of 150 bp.
To do this, proceed as follows:

1 Open the chip data file that contains the results to be analyzed in the Data 
context and switch to the Result Flagging tab.

2 Switch to the Form mode going to Result Flagging > >  > Form or by clicking 

the  icon in the toolbar.
3 Choose the Search Fragment with Purity form the Select Form list.

The Search Fragment with Purity form is displayed.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See “User Role Model” on page 39 for details.
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4 Fill out the form following the 3 steps:

a Specify the fragments to search for

Define the fragment size(s) to be searched for by clicking on the (+) 
button to add a fragment and then enter the size in bp for the first 
fragment. It is possible to add several fragments to the list.

b Specify options

Enter the required purity for the fragment size(s) and the tolerance, both 
in % in the section. If you defined several fragment sizes and want all of 
these to be present in the flagged samples, select the option All of them 
must be present. If you only require that one of the sizes is present, select 
the option Any of them can be present.

c Specify Results

Select the color with which the samples that meet the criteria should be 
marked. If desired modify the labeling text.

Optionally select the color with which samples that do not meet the 
criteria should be marked and modify the labeling text.

5 Apply this rule to the samples by going to Result Flagging > >  > Apply Result 

Flagging or clicking the  icon in the toolbar.

All samples are re-evaluated according to the result flagging rule and 
displayed with the respective colors.
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Color Indication
The results are displayed:

• On the Chip Summary Tab:

The colors in the Result Flagging column show which sample matches which 
rule.
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• On the Gel Tab and on the small gel image on the Lower Panel:

The spot on top of the lane is colored if the sample matches a result flagging 
rule.
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• On the Resultssub- tab in the Electropherogram or Gel Tab:

Result Flagging Color: color of the result flagging rule that the current sample 
matches.

Result Flagging Label: label of the result flagging rule that the current sample 
matches.
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How to Use the Editor Mode
The editor mode for result flagging is a powerful way for advanced users to 
create your own result flagging rules.

To define a result flagging rule for a selected chip data file:

1 Open the chip data file in the Data context and switch to the Result Flagging 
tab.

2 Switch to the Editor mode going to Result Flagging > >  > Editor or by clicking 

the  icon in the toolbar.

3 Edit a rule that was created within the Form mode. -OR-

OR

Create a new rule going to Result Flagging > >  > Create New Rule > or  > 

Duplicate Selected Rule by clicking the  icon or  icon.

4 Click the Edit button next to the Label field and enter or modify the result 
label for this rule. 

The result label can be any arbitrary text.

5 Click the Edit button next to the Condition field and enter or modify the logic 
expression for this rule.

Expressions are built up of functions, variables, operators, and values. You 
can manually type in the expressions. But you can also double-click the 
items in the Functions, Variables, and Operators lists, to insert them in the 
respective fields. As an example for a logic expression for the rule 
condition, enter  
NumberOfPeaks > 9 AND PeakFoundAuto(150). With this rule, all 
samples can be found that have more than nine peaks while one of them has 
a size of 150 bp ± 10%. Detailed descriptions of the available functions as 
well as the required syntax and examples are shown in the Help field at the 
bottom of the screen.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model ( “Access Control” on page 39) for 
details. 
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6 Click the Edit button next to the Comment field and enter or modify a 
comment for this rule.

7 Click the Edit button next to the Color field and select a color. If you check 
the Gradient check box, you can assign a color gradient to the rule. It is 
useful for example to use this gradient function for purity or concentration.

8 If necessary, generate additional rules.

a To rearrange the order of the rules go to Result Flagging > >  > Move 

Selected Rule > or  > Move Selected Rule Down  or click the  and  
icons in the toolbar.

b To reset the form go to Result Flagging > >  > Reset Form or click on the  
icon in the toolbar.

9 To apply the rules to your measurement results, go to Result Flagging > >  > 

Apply Result Flagging or click the  icon. 

If there still are syntax errors in the rule definitions, an error message 
appears. All samples are re-evaluated according to the result flagging rules 
and displayed with the respective colors. See “Color Indication” on 
page 150 for more information on the color codes.

You can reuse result flagging rule definitions, see “Exporting Result Flagging 
Rules” on page 179 and “Importing Result Flagging Rules” on page 172.

NOTE If the entered syntax is not correct, the invalid part is displayed in red color.

NOTE Additional information is available in the Help panel at the bottom of the screen. This 
panel provides context-specific help, including examples.
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Example: Result Flagging
Sample 1 contains 100 μg/mL proteins. The electropherogram shows 2 peaks 
for 2 different proteins, which could be separated. One peak can be found at 
32 kDa (LDH). 

Sample 2 contains 60 μg/mL proteins and shows 3 peaks.

Sample 3 contains 80 μg/mL proteins and shows 5 peaks.

Now, the following rules are defined:

1 Is there a peak at 30 kDa +/- 7%?

Rule 1:  
PeakFound(30, PER, 7)

2 Is the total concentration of proteins higher than 90 μg/ml?

Rule 2:  
TotalConcentration > 90

3 Were 5 to 10 peaks found?

Rule 3:  
NumberOfPeaks >= 5 AND NumberOfPeaks <= 10

Alternative Rule 3:  
NumberOfPeaks BETWEEN (5,10)

Applying these rules in the given order (in Normal mode) leads to the 
following results: 

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model (“Access Control” on page 39) for 
details.
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For sample 1, rule 1 matches and defines the color. Rule 2 would also match, 
but is not checked, because the procedure stops at the first match.

For sample 2, none of the rules match, if there is no peak at 30 kDa +/- 7%. 
Therefore, this sample will get the default color.

For sample 3, only rule 3 matches and defines the color.
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Working with Chip Data and Methods/Assays

You can make efficient use of the chip and method/assay data generated by 
the 2100 Expert Software, if you know the following fundamentals and 
operating techniques:

• “2100 Export Data Overview” on page 159

• “Handling Methods” on page 162

• “Handling Chip Data” on page 166

• “Organizing, Backing up, and Archieving 2100 Expert Data” on page 167

• “Importing Data” on page 169

• “Exporting Data” on page 173

• “Printing Reports” on page 180

• “Configuring Tables” on page 187

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model (“Access Control” on page 39) for 
details.
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2100 Export Data Overview

The 2100 Expert Software manages data in the following different formats:

• Method/assay files (.xsy)

• Chip data files (.xad)

• Comparison files (.xac)

• Verification result files (.xvd)

• Diagnostics result files (. xdy)

• Result flagging rule files (.xml)

Method/Assay files
Method/Assay files (.xsy) contain the following information:

• Data acquisition and analysis setpoints

Acquisition setpoints are instrument commands and acquisition 
parameters. Analysis setpoints are evaluation parameters, some of which 
you can modify.

• Method/Assay information

All parameters defined by the method/assay, such as method/assay type, 
title, and version.

This information includes:

• Method/Assay type, title, version, and all other parameters defined by 
the method/assay.

• Study configuration

• Instrument configuration

• Reporting configuration

• Workflow configuration

• Chip and sample information

These are sample names, sample and chip comments, and lot numbers.

• Ladder table and peak table

• Result flagging rules

• The audit trail and the signature log with all signatures of the involved 
users.
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Chip data files
Chip data files (.xad) contain the following information:

• Measurement results

After each chip run, the measurement results—also called “raw data”—are 
automatically saved in a new chip data file. Electrophoretic measurement 
results are pairs of migration time and fluorescence intensity values.

• Base method/assay information

Because a chip run is always based on a method/assay file, all information 
from the method/assay file becomes part of the chip data file.

• Run log

Events occurring during the chip run, such as the start and end time, or any 
errors or problems are entered in a “run log”, which is also saved in the 
chip data file.

• Evaluation information

These are modifications you made during data evaluation, such as modified 
gel coloring, manually set markers, manual integration, modified setpoints, 
modified result flagging rules, or definitions of new markers and regions.

• The audit trail and the signature log with all signatures of the involved 
users

Comparison files
You can compare the measurement results from different chip runs (data files 
of same method/assay class only) by collecting samples from different chip 
data files (.xad) and storing them in a comparison files (.xac). It is then 
possible to overlay electropherograms of these samples, for example, but also 
to compare gel-like images or data tables.

Comparison files also contain an audit trail and a signature log with all 
signatures of the involved users.
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Verification result files
Verification result files (.xvd) contain results of qualification tests regarding 
the 2100 Bioanalyzer system hardware and software. The files are stored in 
the “..\validation” subfolder of the 2100 Expert Software installation 
directory. For each verification run, an .xvd file is generated. 

Date and time of the verification run are included in the file name. Example: 
“Verification_23-05-2005_10-28-40.xvd”. 

Verification files also contain an audit trail and a signature log with all 
signatures of the involved users.

Diagnostics result files
To ensure proper functioning of the 2100 Bioanalyzer instrument you should 
run hardware diagnostics tests on a regular basis. The results of these 
hardware tests are stored in diagnostics results files (.xdy) in the “..\
diagnosis” subfolder of the 2100 Expert Software installation directory.

Result flagging rule files
You can export and import result flagging rules from other method/assay or 
chip data files. Result flagging rules are stored in .xml files.
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Method Templates
The 2100 Expert Software provides method templates. They are designed for 
measurements using the available kits. They are not suited to be run directly, 
but must be adapted into custom methods. For example, a necessary adaption 
for these methods might be to add an instrument.

Predefined Assays
Predefined assays are provided with 2100 Expert Software. They are meant 
and prepared for measurements using the available Analysis kits. 

Predefined assays such as DNA 1000 are write-protected. Although you can 
open predefined .xsy files and edit some of their properties, you cannot save 
any changes under the original file name.

Methods
You can derive your own methods from the predefined methods as described 
in “How to create a custom method:” on page 163.

The main benefit of custom methods is that you have to do the following only 
once in the method file, instead of doing it again and again in the chip data 
files:

• Enter the general properties of the method such as the configuration of 
study, instrument, reporting, and workflow.

• Modify method setpoints (data analysis setpoints).

• Enter information on chip and samples.

For example, if your sample names are to be the same for a series of chip 
runs.

• Define rules for result flagging.

NOTE When creating a method from a template or from a pre-existing method, it initially has the 
state method development. The user who saved it as a new method, will automatically be 
set up as an analyst in the workflow. In this state only he/she can run the method after 
adding an instrument. This way the method can be tested without the need to change the 
state to ready to use.
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You can modify methods at any time. See “How to modify a custom assay 
method” on page 165.

How to create a custom method:

To create a method:

1 Switch to the Method context.

2 From the Methods menu, select a method.

OR

Select File > Open and open a method (.xsy) file.

The file appears in the TreeView Panel.

3 Switch to the General Properties tab to specify the Study Configuration settings.

• To add a new study to the list of studies, click Add. Then fill the 
remaining fields.

• To modify the settings of an existing study, select it from the list, click 
Modify and edit the fields in question. 

4 On the Instrument Configuration sub-tab, you see a list of all validated 
instruments.

• Select the instruments allowed for this method and click the Add button 
to move them to the list of Allowed Instrument Configurations.

• To remove an instrument from this list, select it and click the Remove 
button.

NOTE If you just want to view the properties of a method, you can open the method file in 
read-only mode, ensuring you do not make accidental changes.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model (“Access Control” on page 39) for 
details.

NOTE You can also import the instrument settings from another method file (for example, a 
similar method). Click the Import button and select the method file to be used.
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5 On the Reporting Configuration sub-tab, define the items that are to be 
included in the report. 

6 Switch to the Assay Properties Tab to modify the method setpoints if required.

7 Switch to the Chip Summary Tab to enter chip and sample information.

8 Define flagging rules on the Result Flagging Tab.

9 Select Save As from the File menu. 

The Save As dialog box appears.

10 Under Save as type, select (.xsy), and enter a name and location for the new 
method.

11 To create the new method, click Save.

12 You need to confirm this action with your electronic signature.

NOTE You can also import the report settings from another method file (for example, a similar 
method). Click the Import button and select the method file to be used.

NOTE When creating a method from a template or from a pre-existing method, it initially has the 
state method development. The user who saved it as a new method, will automatically be 
set up as an analyst in the workflow. In this state only he/she can run the method after 
adding an instrument.

NOTE This way the method can be tested without the need to change the state to ready to use. 
In this state the method can also be run on instruments that are not validated.
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How to modify a custom assay method
To modify a custom assay method:

1 From the File menu select Open.

The Open dialog box appears. 

2 Select a method (.xsy) file and click Open.

The method appears in the TreeView Panel and the Assay Properties Tab is 
displayed. 

3 Modify the method by making changes on the following tabs:

• Modify study, instrument, reporting, and workflow settings on the 
General Properties Tab.

• Modify method setpoints on the Assay Properties Tab.

• Modify or enter additional chip, sample, and study information on the 
Chip Summary Tab.

• Define or modify flagging rules on the Result Flagging Tab.

4 If the method is now completely set up, switch back to the General Properties 
tab and click the Release for use button. 

5 From the File menu select Save to save the method with the current name or 
Save as to save it with a new name.

You need to confirm this action with your electronic signature.

NOTE You cannot save modifications to predefined assays method templates.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model (“Access Control” on page 39) for 
details.

NOTE The study description is stored in the 2100 Expert system file. Altering the study 
description of a method will not affect the entries in the data files that were previously 
generated from this method. To update this information in the data files, too, they must be 
opened, and the study must be assigned again.
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Handling Chip Data

Chip data (.xad) files are automatically generated at the end of a chip run. The 
.xad files are given names that correspond to the choices you have made in the 
Options dialog box (see “How to Specify Data File Names and Directories” on 
page 207).

Modifying and saving chip data files
2100 Expert Software allows to re-open chip data files, reanalyze them using 
different evaluation parameters and store the new results. You can save 
modifications either to the original file (File > Save) or under a new file (File > 
Save As).

If you alter the data shown in any way after it has been saved and try to exit 
the program or switch to a different context (to acquire new data, for 
example), a dialog box will appear asking whether or not you wish to save the 
changes.

Opening chip data files as read-only
A chip data file can be opened as read-only; the Title Bar will show 
“(Read-Only)” at the end of the filename. The read-only file can be edited but 
may not be saved under the same name. If you attempt to save an edited 
read-only file, and error message will be displayed explaining that the file is a 
read-only file. 

The benefit of opening chip data files as read-only is to prohibit you or other 
users from making changes that would alter the file in any way. Because the 
2100 Expert Software allows you to open chip data files, modify data, and save 
them, you may prefer to ensure that the original parameters that were used to 
create the file are not altered.

NOTE Raw data acquired from the 2100 Bioanalyzer system is not changed—only evaluation and 
display of the results can be changed and saved.
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Organizing, Backing up, and Archieving 2100 Expert Data

As you begin to work with the 2100 Expert Software, it is good practice to 
organize your files. If you are not the only user of the bioanalyzer, creating a 
directory within which to save your files is recommended; having each person 
save files to their own directory will speed the process of finding a particular 
file when someone wishes to examine the data again. Even if only one person 
uses the 2100 Expert Software, it is still wise to review your files periodically, 
archive files you are no longer using but wish to save, and discard unneeded 
files.

With the Security Pack installed, the 2100 Expert Software takes this task over 
from you and saves all the created data files in the Secured Area directory. In 
the data folder you will find folders for each assay class and each assay 
subclass. Underneath each assay subclass you can find a folder for each 
method and finally in this method folder you will find a folder for each data 
file created on your system.

Organizing 2100 Expert Data
Each user in your laboratory may want to specify a particular prefix that will 
easily differentiate their data files from any others.

To do this, switch to the System context, go to the System Wide Settings tab, and 
select Data Files in the tree navigation. Then activate the Prefix check box, and 
edit the prefix string as you require. Note that you can also modify the file 
prefix before you start a chip run. Additionally, you may specify that a new 
directory is created each day for storage of that day’s runs. To do this, activate 
the Create Daily Subdirectories check box on the same screen.

You can specify the file prefix every time before you start a chip run in the 
Instrument context.
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Backing up 2100 Expert Data
It is strongly recommended to save your files to a backup drive or on CD/DVD 
on a regular basis. This allows to retrieve the data in case of a system crash or 
other cases of data loss. For users of the 2100 Expert Security Pack, data 
backup is in the responsibility of the backup operators or the 2100 
Administrators. 2100 Expert Software provides these users with the rights to 
access the Secured Area of the file system with the Windows Explorer and 
backup tools for this purpose.

Archiving 2100 Expert Data
The difference between archiving and backing up is that in the archiving 
process the data will be removed from its original place and moved while 
during the backup process only a copy is taken (depending on the tools you 
use).

It is a good idea to periodically archive your files to a CD/DVD to remove them 
from your hard disk. Depending on the amount of hard disk space available to 
the 2100 Expert Software, you may need to clear space on your hard drive to 
ensure that you will have enough room to save upcoming chip run data.

For users of the 2100 Expert Security Pack, archiving is done by the backup 
operators or the 2100 Administrators. 2100 Expert Software provides 
archiving functionality to users with either of these roles. Additionally, these 
users have the rights to access the secured area of the file system with the 
Windows explorer and tools for this purpose.

See “Archieving Data” on page 217 for details.
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Importing Data

When working with method/assay (.xsy) or chip data (.xad) files, you enter 
specific information that you may want to reuse. To support the reuse of data, 
2100 Expert Software has the following import capabilities:

• “Importing 2100 Bioanalyzer System Files” on page 169

• “Importing Data Analysis Setpoint” on page 170

• “Importing Chip and Sample Information” on page 171

• Batchwise importing files into a secured state (“To import multiple 
2100 Expert data files:” on page 216)

You can import result flagging rules definitions for result flagging into 
electrophoretic method/assay or chip data files:

• “Importing Result Flagging Rules” on page 172

Importing 2100 Bioanalyzer System Files
You can import data, assay and method files that were generated with other 
Agilent 2100 Bioanalyzer systems.

How to Import Assay, Method and Chip Data Files

To import assay or method files:

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model (“Access Control” on page 39) for 
details.

NOTE Note that the imported files have the state method development and cannot be used 
directly for a measurement. If you imported an assay file that was generated with 2100 
Expert Software without security pack, the missing information (such as allowed 
instruments or workflow information) has to be added. If you imported a method file from 
2100 Expert Software with security pack, information such as the instrument to be used 
and the workflow settings need to be updated.
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1 Switch to the Method/Assay context.

2 From the File menu, select Import to display the Open dialog box.

3 Select a .xsy (2100 Expert method/assay file) file.

4 Click Open.

5 You need to confirm this action with your electronic signature.

The imported file appears in the Tree View Panel, and the Method 
Properties/Assay Properties tab shows information about the method/assay.

Upon importing, the file gets converted to a new 2100 Expert method/assay 
file (.xsy).

To import chip data files:
1 Switch to the Data context.

2 From the File menu, select Import to display the Open dialog box.

3 Select a .xad (2100 Expert chip data file) file.

4 Click Open.

5 You need to confirm this action with your electronic signature.

The imported file appears in the Tree View Panel, and the electropherogram 
grid view shows an overview of all samples.

Upon importing, the file gets converted to a new 2100 Expert chip data file 
(.xad). 

Importing Data Analysis Setpoint
Importing Data Analysis Setpoint

You can import data analysis setpoints from other method/assay (.xsy ) or 
chip data (.xad) files of the same type.

Note the following when importing:

• Electrophoresis files to be imported must be of the same assay/method 
type. This means that you cannot import setpoints from a DNA 1000 
assay/method into a DNA 7500 assay/method, for example.
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To import data analysis setpoints:
1 On the Assay Properties/Method Properties tab, click Import Setpoints.

The Open dialog box appears. 

2 Select the file from which you want to import, and click Open.

All files: the setpoint values are updated in the setpoint explorer, and 
immediately applied to the measurement results (if any).

3 From the File menu, select Save to make the changes permanent.

Importing Chip and Sample Information
On the Sample Information and Study Information sub-tabs of the Chip Summary tab, 
you can enter names and comments regarding chip, samples, and study. The 
information you enter here may be very similar for further chip runs or other 
assays/methods. Once you have entered the information, you can export it 
into a separate file (see “Export Chip Run Data” on page 174), which you can 
then import into other chip data (.xad) or assay (.xsy) files instead of typing it 
anew. 

The import/export files can have the extension .txt or .csv, and have a fixed 
form. 

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model (“Access Control” on page 39) for 
details.

NOTE Importing data analysis setpoints overwrites all current setpoint values.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model (“Access Control” on page 39) for 
details.
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To Import Chip and Sample Information
1 On the Chip Summary tab, click Import.

The Import Sample Information dialog box appears. 

2 Select the file that contains the information you want to import, and click 
Open.

The Sample Information and Study Information sub-tabs of the Chip Summary tab 
update to show the imported data.

3 From the File menu, select Save to make the changes permanent.

Importing Result Flagging Rules
You can import result flagging rules into electrophoretic assay/method (.xsy) 
or chip data (.xad) files. Result flagging rules can be stored in.xml files (see 
“Exporting Result Flagging Rules” on page 179).

To Import Result Flagging Rules
1 Open an electrophoretic assay/method or chip data file in the respective 

context.

2 Switch to the Result Flagging Tab.

3 In the Result Flagging toolbar click .

The Load Rules dialog box appears. 

4 Select the.xml file that contains the set of result flagging rules, and click 
Open.

The imported rules are applied to the data of the assay or data file.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model (“Access Control” on page 39) for 
details.
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Exporting Data

2100 Expert Software allows you to export the results of your chip runs in a 
variety of formats. The exported data can be used for further evaluation with 
other applications, such as text processors, graphic tools, or Microsoft Excel®.

You can export the chip run data of the currently loaded file either manually 
or automatically:

• “Export Chip Run Data” on page 174

More powerful functions for exporting data files are found in the System 
context. See:

• “To export multiple 2100 Expert data files:” on page 215 for exporting 
multiple data files.

• “Archieving Data” on page 217 for archiving complete directories (data files 
and .PDF reports).

If you want to export only parts of your measurement results:

• “Exporting Tables” on page 176

• “Exporting Graphs or Gel-like Images” on page 177

• “Copying Graphs, Gel-like Images and Tables into the Clipboard” on 
page 178

Information that you have entered to document a chip run can be exported for 
reuse in future chip runs:

• “Exporting Chip and Sample Information” on page 174

From electrophoretic assay/method or chip data files, you can also export rule 
definitions for result flagging:

• “Exporting Result Flagging Rules” on page 179

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See “Access Control” on page 39 for details.
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Exporting Chip and Sample Information
On the Sample Information and Study Information sub-tabs of the Chip Summary tab, 
you can enter names and comments for the chip and the samples. The 
information you enter here may be very similar for further chip runs or other 
methods/assays. Once you have entered the information, you can export it 
into a separate file, which you can then import into other chip data (.xad) or 
method/assay (.xsy) files instead of typing it anew.

The import/export files can have the extension .txt or .csv, and have a fixed 
form, which differs for electrophoretic assays.

To export chip and sample information to a file:

1 On the Chip Summary tab, click Export.

The Export Sample Information dialog box appears.

2 Specify a file name and location for the file to which you want to export.

3 Click Save.

Export Chip Run Data

1 Switch to the Data context.

2 In the Tree View Panel, select a chip data (.xad).file or load a file.

3 From the File menu, select Export.

The Electrophoresis Export Options dialog box appears.

4 Select the export categories, and specify a target directory.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model (“Access Control” on page 39) for 
details.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See “Access Control” on page 39 for details.
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5 Click Export.

Several system dialog boxes appear, one for each export category, allowing 
you to check and modify names and locations of the export files. Clicking 
the Save button in these dialog boxes finally starts the export.

6 Confirm this action with your electronic signature.

Several system dialog boxes appear, one for each export category, allowing 
you to check and modify names and locations of the export files.

The Export tab of the System context allows you to export multiple data files 
without having to load them first.

See “To export multiple 2100 Expert data files:” on page 215 for details.

NOTE Keep in mind that exporting a chip data file can require up to 20 MB of disk space. In 
particular, exporting electropherograms and gel-like images as .tif or .bmp files may take 
up a lot of disk space.

NOTE If you want to access these exported files and you do not have admin rights, please keep 
in mind to specify a target directory outside the Secured Area folder.

NOTE Otherwise the data will get exported but you will not be able to access it with the 
Windows Explorer since access is only granted to 2100 Administrators and 2100 Backup 
Operators.

HINT Chip run data can be automatically exported every time a chip run has finished. Refer to 
“Exporting Chip Run Data Automatically” on page 176 for details.

NOTE Chip run data can be automatically exported every time a chip run has finished. Refer to 
“Exporting Chip Run Data Automatically” on page 176 for details.
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Exporting Chip Run Data Automatically

1 Switch to the System context and select Auto Export in the tree navigation.

2 Activate the Auto Export check box.

3 Specify the export categories that are to be included in the exported files.

4 Switch to Default Export Directories in the tree navigation and specify the 
target directories.

5 To leave the System context, you need to confirm this action with your 
electronic signature.

From now on, chip run data is automatically exported every time a chip run 
has finished.

Exporting Tables
You can export:

• Result, peak, fragment, region, and ladder tables as .csv files or .xls files.

• Log book tables as .html or .txt files.

NOTE Keep in mind that exporting a chip data file can require up to 20 MB of disk space. In 
particular, exporting electropherograms and gel-like images as .tif or .bmp files may take 
up a lot of disk space.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model (“Access Control” on page 39) for 
details.

NOTE If you stop a chip run, auto export does not take place.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model ( “Access Control” on page 39) for 
details.
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To export a result, peak, fragment, region or ladder table:
1 On the Assay Properties/Method Properties, Electropherogram, or Gel tab, 

right-click the heading row of a table.

2 From the context menu, select Export.

The Export Data dialog box appears. 

3 Enter a file name and choose the destination directory.

4 Select .csv or .xls as export file format.

5 Click Save.

To export a log book table:
1 On the Log Book tab, right-click a table.

2 From the context menu, select Export.

The Export Data dialog box appears. 

3 To specify the file name, the destination directory, and the file type, click 
the ... button. You can choose between HTML file for .html output and Tabbed 
text file for .txt output.

4 Specify whether you want to export the Selected rows only or All visible rows.

5 Click OK

Exporting Graphs or Gel-like Images
You can export graphs or gel-like images as individual graphic files.

NOTE Result tables can be automatically exported every time a chip run has finished. Refer to 
“Exporting Chip Run Data Automatically” on page 176 for details.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model (“Access Control” on page 39) for 
details.
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To export a graph or a gel-like image:

1 Right-click the graph and select the appropriate entry (e.g. Save Gel or Save 
Electropherogram) from the Context menu.

OR

Click the button in the toolbar.

The Save As dialog box appears.

2 To enter a name and choose the destination directory, click File name.

3 To select a graphic file format: .bmp, .jpg, .wmf, .tif or .gif, click Save as type

4 Click Save.

The graph or gel-like image is written to the specified file.

Note the following:

Electropherograms: 

if the grid view is active, an overview image of the electropherograms (of all 
samples and the ladder) is exported.

Copying Graphs, Gel-like Images and Tables into the Clipboard
You can copy graphs and gel-like images into the clipboard. This applies to 
most graphs that can be displayed in the 2100 Expert Software, such as 
electropherograms or standard curves.

You can also copy tables (or parts of tables) into the clipboard. This applies to 
most of the tables that can be displayed in 2100 Expert Software, such as 
result tables or log book tables.

To copy a graph, gel-like image or table into the clipboard:

HINT Electropherograms and gel-like images can be automatically exported every time a chip 
run has finished. Refer to “Exporting Chip Run Data Automatically” on page 176 for details.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model (“Access Control” on page 39) for 
details.
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1 Right-click the graph, gel or table.

2 From the context menu, select Copy Gel/Copy Electropherogram or Copy To 
Clipboard (tables).

OR

Click the  button in the toolbar.

You can now switch to a word processing, spreadsheet, graphics, or other 
application, and paste the graph/gel or table there.

Exporting Result Flagging Rules
You can export result flagging rules for reuse in other electrophoretic 
assay/method (.xsy) or chip data (.xad) files (see “Importing Result Flagging 
Rules” on page 172). Result flagging rules are stored in.xml files.

To export result flagging rules:

1 Open the electrophoretic assay/method or chip data file with the desired 
result flagging rules in the respective context.

2 Switch to the Result Flagging tab.

3 In the Result Flagging toolbar click the icon  (Export Rules to File).

The Save Rules dialog box appears. 

4 Browse for a folder where you want to store the rules, and specify a name 
for the.xml file.

5 Click Save

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model (“Access Control” on page 39) for 
details.
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Printing Reports

For documentation and presentation purposes, you can print reports for 
method/assay (.xsy), chip data (.xad), verification results (.xvd), and 
comparison (.xac) files.

You can print all reports manually, see “How to Print a Chip Run Report” on 
page 181. When printing manually, a preview function allows you to view the 
printout before starting the print job.

The 2100 Expert Software can also be set to print customized chip run reports 
automatically at the end of the run. These reports can be set up to contain 
different information (settings for the manual and automatic print functions 
are maintained separately). See “How to create a custom method:” on page 163 
for more information. 

The 2100 Expert Software can also be set to print customized chip run reports 
automatically at the end of the run. These reports can be set up to contain 
different information (settings for the manual and automatic print functions 
are maintained separately). See “How to Turn on and Configure Automatic 
Printing of Chip Run Reports” on page 185 for more information. 

HINT Beside sending reports to a printer, you can also create .pdf and .html files.
180 2100 Expert Software User Guide



Working with Chip Data and Methods/Assays 5 
Printing Reports
How to Print a Chip Run Report
The following information can be included in a chip run report:

• You can always include:

• Run summary—general data about the method/assay, and sample 
information.

• Assay details—complete list of data analysis setpoints.

• Run Logbook

• Signature Logbook

• Audit Trail

• For electrophoretic chip data files (.xad), depending on the method/assay 
type you can include: 

• Electropherograms

• Gel-like image

• Result tables

• Standard curve

• Calibration curve

To print a report:

1 Switch to the Data context.

2 In the Tree View Panel select the chip data (.xad) file you want to generate a 
report of.

NOTE The contents of the report are specified during the method/assay setup. If a chip run was 
made based on a method/assay that was released for use, you cannot alter the 
pre-defined contents of the report.
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3 From the File menu select Print.

Depending on the file type different dialog boxes appear. 
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4 You generally have the following possibilities:

• select the items to be included in the report from the Print Item section

• select the wells to be included from the Wells (electrophoretic assays) 
section

• select the appropriate options

• specify whether you want to generate the report as a file (PDF or HTML) 
and specify the file path

5 Use the Page Setup and Printer buttons to access system dialog boxes, 
allowing you to select a printer, and specify the print medium and page 
layout.

6 To get a preview of the printouts or files to be generated, click the Preview 
button.

7 To print out the pages or generate the file(s), click Print.

The following example shows the “Run Summary” part of an RNA chip run 
report. 

NOTE Security Pack: You can only select the included Print Items and the additional Options only 
unless the method is released for use. 

NOTE Your selections here are separate from the Auto Print selections (they do not affect each 
other). Both are used by default the next time you print (even after restarting the program).
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How to Turn on and Configure Automatic Printing of Chip Run 
Reports

A report can be automatically printed on a printer or generated as a file at the 
end of each chip run. Saving reports as files can be helpful for documentation 
purposes.

To enable and configure automatic printing:

1 Switch to the System context.

2 Select Run and Result in the tree navigation.

3 Activate the Auto Print check box and click the Settings button next to this 
check box. 

The Auto Print dialog box appears.

NOTE The Auto Print settings are independent from those made via the Print command of the 
File menu.
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4 Adjust the settings:

• In the Print Item section, select the options that are to be included in the 
report.

• In the Save To File section, you can redirect the automatic printouts to .pdf 
and .html files.

Note that no print output is generated if you select the PDF and/or HTML 
option.

• Using the Page Setup and Printer buttons, you can access system dialog 
boxes, allowing you to select a printer for the automatic print, and 
specify the print medium and page layout.

5 Click OK to confirm the automatic print settings.
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Configuring Tables

2100 Expert Software uses various tables to present data:

• Result tables

• Peak tables

• Fragment tables

• Region tables

• Log book tables

In some cases, you might want to reorganize the way the data is presented. To 
do so, you can hide or show columns, change the column sequence, and adapt 
the table height.

The following example demonstrates how to add the migration time to the 
Peak Table.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model (“Access Control” on page 39) for 
details.
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Configuring...

Showing and Hiding Columns
To add the Aligned Migration Time column to the table:

1 Right-click the heading row of a table and select Configure Columns from the 
context menu.

The Configure Columns dialog box opens:

2 Move any desired column headers from the Available list to the Displayed list.

3 Configure the order of the column headers in the Displayed list by using the 
Up and Down buttons. 
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4 Click OK.

A new column Aligned Migration Time is inserted in the table:

To change the column sequence of a table:

1 Position the mouse pointer on a column header.

2 Click and hold the left mouse button to drag the header cell to the desired 
position.

While dragging, a green arrow indicates the target position. 

3 Release the mouse button.

The column has moved to its new position: 

NOTE You can set the column sequence also using the Up and Down buttons in the Configure 
Columns dialog box.
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To increase or reduce the column width:
You can customize the view by changing the column width.

1 Position the mouse pointer between two columns and move it until the 
cursor’s shape changes to a double arrow.

2 Click and hold the left mouse button and drag left or right.

3 Release the mouse button.
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Administering System Functions and the Security Pack

The 2100 Expert Software provides the following configuration options and 
system functions:

• Users can be added, removed, and assigned various roles. See “Access 
Control” on page 193 for details.

• Default data file names and directories can be specified. Also, settings such 
as for automatic printing or automatic data export can be set up. See 
“Configuring the 2100 Expert Software” on page 207 for details.

• Chip data files can be exported and imported. See “Exporting and 
Importing Multiple Data Files” on page 215 for details.

• Data can be archived to free system space. See “Archieving Data” on 
page 217 for details.

• Log books are provided that record all important actions and messages in 
the 2100 Expert Software. See “Using Log Books” on page 220 for details.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model (“Access Control” on page 39) for 
details.
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Access Control

Among others, the 2100 Expert Software with the Security Pack license 
provides functionality for access control. With this access control 
functionality, only authenticated and authorized users can access and modify 
data, i.e. any electronic record created or managed by 2100 Expert Security 
Pack.

How 2100 Expert Software Manages Users and Data Access
2100 Expert Security Pack does not add another level of user management. It 
utilizes the user accounts setup which is managed by the operating system. 
The users can either be managed locally (user accounts on the computer) or in 
a company environment (user accounts managed by a directory service).

Analogously, password management is taken from the Windows operating 
system. The requirements in respect to user and password management posed 
in controlled environments, must be achieved by configuring the operating 
system account and password policies accordingly.

However, not all the users set up at the local PC or domain service are allowed 
to access the 2100 Bioanalyzer System. During its setup, the 2100 Expert 
Software will be configured to grant access only to those operating system 
users, which have been selected by a 2100 adminstrator.

Here it is also defined, which data and functionality a user is allowed to 
access. The 2100 Expert Software uses roles to determine which data and 
functions a user is allowed to access. Unless a user has already been assigned 
a particular role within the 2100 Expert Software, this user has no access to 
the 2100 Expert data.

There are direct consequences for a user management that is performed by the 
operating system: When a user changes his/her password within the 
company's directory service, this new password is also valid for the 
2100 Expert Software. 
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To protect the data generated with the 2100 Bioanalyzer System from access 
via the Windows environment, a so-called Secured Area is defined. The Secured 
Area is a file directory where all Security Pack data gets stored in. It is defined 
as a folder belonging to the generic 2100 System account. This account 
perfoms the underlying security management tasks and is not visible inside 
the 2100 Expert Software. The System account is not assigned to any roles.

As a consequence the data in the Secured Area is controlled by the 2100 Expert 
Software. Access to the directory through Windows Explorer should only be 
granted via the software provided user roles "Administrator" and "Backup 
Operator" as this is recorded in the audit trail. Other users, including Windows 
users are not granted access to the secured data.

As an example, you may have a PC with 15 user accounts set up in the 
operating system plus the 2100 System account. Only 5 of these users are also 
set up as 2100 Expert Software users and, therefore, can access data through 
the 2100 Expert Software. But only one of them has the role 2100 
Administrator and can, thus, access the data also with the Windows Explorer.

Managing User Accounts and Roles
With the Security Pack license installed, the user management functions are 
activated. These functions are only available to users with the role 
administrator.

For more information on the various user roles, see User Role Model (“Access 
Control” on page 39).

To Add a New User to the 2100 Expert Software:

1 Switch to the System context and go to the Users and Roles tab.

2 Select Users and Roles > Add User.

The Select User dialog box opens.
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The appearance of this window depends on the installed operating system.

3 Select the user you want to add either from the local users or from your 
company’s domain server.

4 To add him/her to the list of selected users, click Add. You can add several 
users to this list.

5 To create user accounts for all selected users in the 2100 Expert Software, 
click OK

6 You need to confirm this action with your electronic signature.

The new users now appear in the tree view panel. 

NOTE To select a user for 2100 Expert Software, his/her user account must already be set up in 
the operating system environment. This can only be done by an operating system 
administrator. 
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To assign roles to a user or to remove roles from a user:
1 Switch to the System context and go to the Users and Roles tab.
2 Click the name of the user in question in the tree view panel.

The User Information of the selected user is displayed. 
3 Check the roles that you want to assign to the user. Uncheck the rules that 

you want to remove from the user.
4 When leaving the Users and Roles tab, you need to confirm the changes with 

your electronic signature.

How to Enable and Disable a User Account
A 2100 Expert Software user account may be disabled. Two possible cases 
cause a 2100 Expert user account to be disabled:
• If the operating system user account is disabled, the respective 2100 Expert 

account is also disabled. This can happen, for example, due to several failed 
attempts to log into the operating system.

• The operating system user account may still be working, but the 
2100 Expert account is disabled. The account could have been actively 
switched off by the 2100 administrator, if access for a certain user should 
be prohibited. Additionally, also 2100 expert may disable the account after 
too many failed attempts at login or signing.

A disabled account can only be enabled by a 2100 administrator. If the user 
account cannot be enabled again within 2100 Expert Software, the operating 
system administrator must check the user’s account in the operating system 
and enable it again.

To enable or disable a user account within 2100 Expert Software:
1 The User Information including the current status of the selected user is 

displayed.
2 Switch to the System context and go to the Users and Roles tab.
3 To enable or disable a user account, right-click the user’s name in the tree 

view panel and select the appropriate entry from the context menu.
The status of the user changes accordingly. 

4 When leaving the Users and Roles tab, you need to confirm the changes with 
your electronic signature.

HINT If you are unsure whether you selected the correct user in the tree view panel, you can 
click the Full Name button to retrieve the user’s full name from the Windows user 
account.
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How to Change Your Password
If for security reasons a user needs to change the password immediately, for 
example if it has been spied upon, this can be done directly in the 2100 Expert 
Software.

To change your password:

1 From the File menu in any context, select Change Password.

The Change Password dialog box opens.

2 Enter your old password to authenticate yourself.

3 Enter the new password twice to verify the correct spelling.

4 To finish the password change, click OK.

NOTE The 2100 Expert Security Pack uses the user accounts from the Windows environment. 
Thus, changing your password from within the 2100 Expert Software will cause that this 
new password will also be required for future logins to the Windows operating system.
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Pre-configurations for the 2100 Expert Software

Setup a default printer
The 2100 Expert Software requires a printer to be setup for the printing of 
reports and for some software features, like result flagging, to function 
properly. This can either be a physical printer, connected to the PC or laptop 
the 2100 Expert Software is running on, a network printer or a virtual 
printers, like PDF or XPS printers.

To setup a printer on your PC or laptop, please follow the instructions below:

1 Windows 7 OS: To setup a default printer, log on to the operating system 
with an administrative account, select the Start button and then Devices and 
Printers. Add or select a printer, then select Set as default printer.

OR

Windows 10 OS: To setup a default printer, log on to the operating system 
with an administrative account, select the Start button and then Settings. Go 
to Devices and add or select a printer. Then select Make default.

NOTE Security Pack Users: Please be aware that you have to setup a printer by logging into the 
generic 2100 System account. Then follow the instructions for your operating system.
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Default Printer margins

Configure XPS properties in Windows 7

1 In the 2100 Expert Software, open File > Page setup, then set the margins to 
0.5 inches each and click OK. Make sure the paper size is Letter and Source is 
Automatically Select.

NOTE When working with 2100 Expert Software B.02.08 and Operating System Windows 7, 
certain page margins are not compatible with the document printer.

To modify the printer margins, please follow the instructions below.
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2 Log on to the operating system with an administrative account, select the 
Start button and then Devices and Printers. Right click on Microsoft XPS 
Document Writer, select Printing preferences.
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3 Select the Layout tab and choose Orientation: Portrait. Then click on Advanced 
and select Paper/Output and under Paper Size choose Letter and confirm with 
OK.
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Configure regional settings

1 Log on to the operating system with an administrative account, select the 
Start button and then Control Panel.

2 Select the Clock, Language, and Region category.

NOTE Certain issues in the 2100 Expert Software can be solved by ensuring that your computer’s 
regional and language settings are correct.

To review and change the regional settings please follow the instructions below.
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3 Select Region and Language.

4 Ensure that the format is set to English (United States) and click on the 
Additional Settings button.
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5 In the Customize Regional Options window, click on the Date tab (see the green 
square) at the top of the window, then confirm that the Short date and Long 
date formats are as shown below. If either format is different than shown 
below, left-click on it and then select the correct format in the drop-down 
menu.

6 Click on Apply and then OK to save any changes. You can click on OK again to 
close down the window.
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Display settings
The 2100 Expert Software does not support display resolution settings that 
exceed 2048 * 1536 pixels. To prevent or resolve problems with your 2100 
Expert Software, decrease the display resolution to below 1920 * 1200 
pixels:

1 Windows 7: Right-click on your desktop and select Display settings from the 
menu. In the new windows determine a display resolution below 1900 * 
1200 pixels from the drop-down list. Confirm by pressing OK.

OR

Windows 10: Right-click on your desktop and select Display settings from the 
menu. In the new windows select Advanced display settings and determine a 
display resolution below 1900 * 1200 pixels. Confirm by pressing Apply.
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USB-to-Serial adapter configuration
The 2100 Bioanalyzer instrument can be connected to a USB port of the PC by 
using the auxiliary USB-to-Serial adapter cable. The correct drivers for the 
Agilent USB adapter cable (black) are available on your 2100 Expert Software 
media. A previous version of the adapter cable (blue/silver) is not supported 
for Windows 7 or Windows 10. Moreover, other manufacturer’s USB-to-serial 
adapter cables are not supported and should be exchanged with the standard 
Agilent USB adapter cable (black) that is delivered with each system.

Once the adapter drivers are installed on the PC, a COM-port number will 
be assigned to the adapter. In case your PC has other physical COM-ports 
assigned, the available numbers become restricted. Double digit values for 
the 2100 Bioanalyzer USB-to-Serial adapter cable COM-port are not 
supported and need to be changed accordingly:

1 Open the device manager.

2 Navigate to the Ports section and right-click on the USB Serial Port to select 
Properties.

3 Select the Port Settings menu tab. 

4 Open the Advanced settings by clicking the corresponding button.

5 Select an appropriate COM-Port Number with a single digit only. Confirm by 
pressing OK.
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Configuring the 2100 Expert Software

The available options for configuring the 2100 Expert Software can be found 
in the System context on the System Wide Settings tab.

How to Configure the 2100 Expert Software

How to Specify Data File Names and Directories
The measurement results are stored automatically when the chip run is 
complete. To make it easier for you to identify the chip data files, you can 
configure an automatic naming scheme for the files.

However, due to the regulations of the FDA compliance, the names of the files 
and directories cannot be chosen freely. You can only specify a custom prefix 
that will be used for the file names.

To specify the names and destination for generated chip data files:

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model (“Access Control” on page 39) for 
details.
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1 Select Data Files in the tree navigation.

The Data Files screen becomes visible:

2 In the Data File Name section, select the check boxes of the strings you want 
to insert in the file names:

Option Meaning
Prefix Inserts an arbitrary string to identify the data 

file. This string can be modified. The default file 
prefix is "2100 expert".

Assay Class Inserts the assay class in the file name. 
Examples: "DNA1000".

Serial Number Inserts the serial number of the Agilent 2100 
Bioanalyzer instrument used for the chip run.

Date Inserts the date of the chip run.
Time / Counter Inserts the time of the chip run/inserts an 

auto-incremented 3-digit number.
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3 In the Data File Directory section, specify the Default Directory where the chip 
data files are to be stored. Use the Browse button to select a directory or 
click Reset if you want to use the ..\ > Data directory under the 2100 Expert 
Software installation directory.

4 Optionally, you can select the check box Create Daily Subdirectories if you 
want daily subdirectories to be created. 

This option helps you to better organize your chip data files. If selected, a 
subdirectory is created for every day in which a chip run was started. The 
name of the subdirectory has the format "YYYY-MM-DD", for example, 
"2005-01-22". All chip data files generated on this day will be stored in this 
subdirectory.

5 In the Data File Format section, select whether you want to save the data 
files in Binary Format or in XML Format. 

6 Use the Prefix field to specify a default prefix for the created files. This 
default prefix can be changed by every analyst in the Instrument context for 
each chip run.

How to Set Run and Result Options
You can select several options such as to pause the analysis on setpoint 
changes, the maximum log file size, or the graph colors.

The 2100 Expert Security Pack restricts access to data and functionality to 
users who are logged in with certain roles. See User Role Model for details 
(“Access Control” on page 39).
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To set the Run and Result options:

1 Select Run and Result in the tree navigation.

The Run and Result screen becomes visible:

2 In the Advanced section, you can

• select Auto Run to activate the automatic start of a chip run once the lid of 
the Agilent 2100 Bioanalyzer instrument is closed and a chip suiting the 
selected assay is detected.

• select Auto Print to enable the automatic report printing function.

You can now click Settings to display the Autoprint dialog box, where you set 
the options for automatic printing after a chip run is complete.

NOTE The Auto Print settings are independent from those made via the Print command of the 
File menu.
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3 In the Analysis section, you can activate the Pause Analysis on Setpoint Change 
function.

If this function is not active, the measurement results are recalculated 
every time after you change a setpoint. If you need to change several 
setpoints at once, activating this function saves you time, because the 
results are only recalculated when leaving the setpoint explorer or when 
starting the analysis manually with the start button.

4 In the Graph Signal Color section, click the colored rectangles to the right of 
the signals. 

You can now choose a new color for the selected signal in the Color dialog 
box.

To define auto export options:
The 2100 Expert Security Pack restricts access to data and functionality to 
users who are logged in with certain roles. See User Role Model for details 
(“Access Control” on page 39).

1 Switch to the System context and select the System Wide Settings tab.

2 Select Auto Export in the tree navigation.

The Auto Export screen becomes visible:
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3 To export a datafile automatically after every chip run, activate the Auto 
Export check box.
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4 Specify which elements are to be included in the exported file for 
electrophoresis measurements.

5 Select Default Export Directories in the tree navigation and define the default 
directories for the various file types. Optionally, you can activate the Create 
daily subdirectories check box to automatically export the files of each day to 
separate directories.

6 When leaving the System context, you are asked to confirm your changes 
with your electronic signature.

How to Activate Software Licenses
By installing the 2100 Expert Software you have also installed a license 
administration tool. This tool is used to activate the different software 
modules. The following licenses are available:

• 2100 electrophoresis license

• 2100 Security Pack license

• 2100 instrument control license

To activate an additional software license:

1 Select Help > Registration to open the License Administration Tool window.
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2 Switch to the Add License tab.

3 In the Select Product field, the Agilent 2100 Bioanalyzer must be selected.

4 In the Select Module field, select the license for the software module that you 
want to activate.

5 Enter the correct License Key and click Add.

A message box informs you whether the license key was added successfully.

6 If you want to add more licenses, repeat the previous two steps for every 
license key.

7 To close the License Administration Tool window, click Exit.

The licensed software modules are now activated and can be used.

NOTE If you added the license key to activate the security pack, the 2100 Expert Software closes 
and the secured file area will be set up. Follow the instructions displayed in the different 
pages of the setup wizard.

NOTE Store your license keys in a secure place and make sure you do not lose them.
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2100 Expert Software allows to export and import multiple data files at once. 
With this functionality, you produce copies of these files outside the secured 
area, for example, to use them for presentations or analysis with external 
tools. 

To export multiple 2100 Expert data files:
1 Switch to the System context and go to the Import - Export tab.

On the left side of this tab, you can see the structure of the Secured Area of 
the 2100 Expert Software. On the right side you see the structure of the 
currently selected import directory. 

2 If you want to export data to a different directory, click the Browse button 
and select the correct directory. 

3 Activate the Export radio button.

4 In the structure of the Secured Area, navigate to the folder or file to be 
exported (open folders by double-clicking them) and click the >>> button.

The selected folder or file is added to the structure in the selected export 
directory. 

5 If you need to export more folders or files, repeat this step for all remaining 
data to be exported.

6 If you want the files to be exported including their original path, activate 
the Include Path checkbox.

7 To start the actual exporting procedure, click the Export button.

The signature dialog opens and lists all files that are selected to be 
exported. 

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model (“Access Control” on page 39) for 
details.

NOTE This behavior is in contrast to the archiving functionality, which moves the files to a 
distinct destination. Exporting does not remove any files from their original location.

Files that are marked to be read-only will not be archived.
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After the exporting procedure is finished, you can click the Report button to 
see, whether all files have been successfully exported or not. This information 
is also written to the system log file.

The files that are exported can now be normally accessed with external tools 
without any restrictions.

To import multiple 2100 Expert data files:
1 Switch to the System context and go to the Import - Export tab.

On the left side of this tab, you can see the structure of the Secured Area of 
the 2100 Expert Software. On the right side you see the structure of the 
currently selected import directory.

2 If you want to import data from a different directory, click the Browse 
button and select the correct directory. 

3 Activate the Import radio button.

4 In the structure of the import directory, navigate to the folder or file to be 
imported (open folders by double-clicking them) and click the <<< button.

The selected folder or file is added to the list below the Secured Area. 

5 If you need to import more folders or files, repeat this step for all remaining 
data to be imported.

6 Click the Import button to start the actual importing procedure.

The signature dialog opens and lists all files that are selected to be 
imported. 

After the importing procedure is finished, you can click the Report button to 
see, whether all files have been successfully imported or not. This information 
is also written to the system log file.

The files that are imported to the Secured Area can now be normally accessed 
with 2100 Expert Software.
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It is recommended that you regularly archive data to preserve systemspace 
and to alleviate file handling and file search. 2100 Expert Software will not 
allow deleting electronic records, but will allow you toremove files after 
successfully completed archiving operations. 

Users that have the roles 2100 administrator and backup operator have the 
necessary read (for performing a backup) and write (for restoring) 
permissions in the secured area. Thus, they are able to both do regular copies 
and to apply functionality of an external backup system to that part of the file 
system occupied by the secured area.

2100 Expert Software does not provide any other backup functionality besides 
the read and write permissions for backup operator and 2100 adminstrator.

To archive 2100 Expert data files:
1 Switch to the System context and go to the Archiving tab.

On the left side of this tab, you can see the structure of the Secured Area of 
the 2100 Expert Software. On the right side you see the structure of the 
currently selected archiving directory.

2 To archive data to a different directory , click the Browse button and select 
the correct directory.

3 Activate the Archiving radio button.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model ( “Access Control” on page 39) for 
details.

NOTE It is recommended to archive the data to the archive folder of the secured area.
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4 In the structure of the Secured Area, navigate to the folder or file to be 
archived (open folders by double-clicking them) and click the >>> button.

The selected folder or file is added to the tree structure in the archiving 
directory. 

5 If you need to archive more folders or files, repeat this step for all 
remaining directories to be archived.

6 To start the actual archiving procedure, click the Archive button.

The signature dialog opens and lists all files that are selected to be archived. 

7 Confirm this action with your electronic signature. 

After the archiving procedure is finished, a message box opens, informing you 
about whether all files have been archived successfully or not. This 
information is also written to the system log file.

The files that are moved to the archiving directory can now be processed with 
external archiving tools or mechanisms.

To de-archive 2100 Expert data files:

1 Switch to the System context and go to the Archiving tab.

On the left side of this tab, you can see the structure of the Secured Area of 
the 2100 Exert Software. On the right side you see the structure of the 
currently selected archiving directory

2 If you want to de-archive data from a different archiving directory, for 
example, from a CD drive, click the Browse button and select the correct 
directory.

3 Activate the De-archive radio button.

4 Click the <<< button.

The secured area directories and file structure follows an inherent rule. So 
a file carries all information to locate it into it's correct location 
automatically. 

5 If you need to de-archive more directories, repeat the previous step for all 
remaining directories to be de-archived.

6 To start the actual de-archiving procedure, click the De-archive button.
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How to Generate Archiving Reports
After you have archived and/or de-archived data files, it is recommended to 
generate and save a report to document your work.

To generate an archiving report:

1 Click the Report button.

The Report dialog box opens.

2 Save the report by clicking the Save button. Then select a file name and 
destination to save the report as .TXT file.
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2100 Expert Software provides several log books to document all relevant 
actions and changes. Due to requirements of data integrity and data security, 
none of the log books can be cleared.

Run Logs
The run log books can be found in the following contexts as sub-tabs of the Log 
Book tab:

• Data context 

• Verification context

• Comparison context

• Method context

They contain events such as the start and end time of a chip run, and any 
errors or problems that occurred during the run. 

All run logs are saved in the data files within the respective context. 

Signature Logs
The signature log books can be found as sub-tabs in the following contexts:

• Data context on the Log Book tab

• Verification context on the Log Book tab

• Comparison context on the Comparison Log Book tab

• Method context on the Log Book tab

• System context on the System Log Book tab 
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They contain all actions that have been performed and confirmed with 
electronic signatures. 

All signature logs are saved in the data files within the respective context.

Audit Trails
The audit trails can be found as sub-tabs in the following contexts:

• Data context on the Log Book tab

• Verification context on the Log Book tab

• Comparison context on the Log Book tab

• Method context on the Log Book tab

• System context on the System Log Book tab 

They contain all actions that have been performed and confirmed with 
electronic signatures. While the signature logs only contain one entry per 
entered signature, the audit trails list all actions in detail. 
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All audit trails are saved in the data files within the respective context.
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System Log
The system log book can be found in the System context under the System Log 
Book tab.

It includes start-up and shut-down events of the 2100 Expert Software, and, 
for example, errors or problems with the connected 2100 Bioanalyzer 
instruments. 

The system log book is saved in config/SystemFile.xml. The log book entries can 
be exported from this file.

The system log book is saved in SecuredArea/System/SystemLogs.xml. This file 
can be exported by the 2100 administrators and the backup operators. 
Additionally, this log book will be split up automatically when a certain file 
size is reached and saved as SystemLogs_ddddTtttt.xml, where dddd and tttt are 
the current date and time. These files can be accessed via the operating system 
or opened in the 2100 Expert Software.
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How to change the display of the logbooks

To deal with logbook table

To sort a log book table: 
1 Click the column header you want to sort the table by.

The log book table is sorted by the entries in the selected column in 
ascending order.

2 Click the column header again to reverse the order.

To filter a log book table:
1 In the Log Book toolbar, click Filter .

The Filter dialog box appears.

2 To define a filter for events from a specified period of time, specify a Start 
Time and an End Time.

3 To define a filter for events with certain entries in a column, specify the 
column name and the value to search for.

4 Use the Filter Action radio buttons to define whether only events that match 
the filter criteria are displayed (Appropriate events only) or whether those 
events are highlighted that do not match the filter criteria while the others 
are still listed (Mark inappropriate events).

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model (“Access Control” on page 39) for 
details.
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5 To apply the filter to the log book table, click OK.

The filter definition in the following example excludes all events from the Run 
Log in the Data context with an Event Type other than Critical.

To remove the filter from a log book table

1 In the Log Book toolbar, click  for reset.

NOTE You can hide/show any of the log table columns, and re-sort the columns by right-clicking 
the table and selecting Columns from the context menu.
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How to Search the Log Book
You can search the various log books for any string. 

To search the Log Book:

1 In the Log Book toolbar, click Find .

The Find dialog box appears.

2 Enter a search string in the Find What field.

3 Use the Column selection list to specify whether you want to search all 
columns or a particular column only.

4 Select the search Direction.

5 Click Find Next.

If the search string was found in an event, the event row gets highlighted in 
yellow.

6 To continue the search, click Find Next.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model (“Access Control” on page 39) for 
details.

NOTE The search is case-sensitive! 
226 2100 Expert Software User Guide



2100 Expert Software User Guide
7 
Running Instrument Diagnostics
Running Instrument Diagnostics     228
How to Run Instrument Diagnostics Test     230

This chapter shows how to use the diagnostic tests to check the 2100 
Bioanalyzer instrument for proper functioning.
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2100 Expert Software provides several tests to check proper functioning of the 
2100 Bioanalyzer instrument. You should perform the tests on a regular basis, 
or if incorrect measurements occur.

Generic 2100 Bioanalyzer Hardware Tests

NOTE The 2100 Expert Software Security Pack restricts access to data and functionality to users 
who are logged in with certain roles. See User Role Model ( “Access Control” on page 39) 
for details.

Diagnostics Test Purpose

Electronics Test Verifies proper functioning of all electronic 
boards in the 2100 Bioanalyzer instrument.

Fan Test Checks if the fan is running at the appropriate 
speed.

Lid Sensor Test Verifies proper operation of the lid sensor, 
ensuring that the laser and LED are off when 
the lid is open.

Stepper Motor Test Checks for proper movement of the stepper 
motor.

Temperature Test Checks if the temperature ramp-up speed of 
the heater plate is within specifications.
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Electrode Cartridge Tests

Test Chips
Test chips are required for the following tests and are included in the 2100 
Bioanalyzer system (G2939BA).

Test Chip Kit for Electrophoresis Methods (reorder no. G2938-68100)

Diagnostics Test Purpose

HV Stability and Accuracy Test Tests high voltage accuracy and stability of all 16 high 
voltage power supplies and the high voltage controller. 
Unused chip (DNA, RNA, or protein) required.

HV Accuracy Test (On-Load) Check of channel-reference diode in transmission direction 
(Only available for G2939A and G2938C instruments.).

Short Circuit Test Checks for instrument leak currents using an empty chip. 
Note: the limits of this test specify an ambient temperature 
of 25 °C and relative humidity less than or equal to 50 %. 
Higher temperatures or relative humidity could result in a 
leak current.

Electrode/Diode Test Checks the photo diode and current-versus-voltage 
performance of the 2100 Bioanalyzer instrument. 
Electrode/diode test chip required.

Optics Test Checks for proper alignment of internal optics and proper 
function of the laser and LED.

Electrophoresis Autofocus Test Checks the focusing capability of the optical system. 
Autofocus test chip required.

Laser Stability Test Measurement of stability of red laser signal.

Test Chip Comment Quantity

Autofocus Test Chip Values for fluorescence and 
offset are printed on the chip. 
Can be used multiple times.

1

Electrode/Diode Test Chip Can be used multiple times. 1
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How to Run Instrument Diagnostics Test

1 Switch to the Instrument context.

2 In the Tree View Panel, select the 2100 Bioanalyzer instrument on which you 
want to run the tests.

3 Switch to the Diagnostics tab.

4 Select the tests you want to run:

• Select the Apply check boxes to select single tests.

• Click Select All to select all available tests.

• Click Unselect All to deselect all tests.

5 Click Start.

You need to confirm this action with your electronic signature.

NOTE Diagnostics tests cannot be run while the 2100 Expert Software is performing a chip run.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model ( “Access Control” on page 39) for 
details.
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6 Follow the instructions given by the 2100 Expert Software. For example to 
put in a test chip in the receptacle of the 2100 Bioanalyzer instrument when 
requested by the software.

The Status column indicates the status of each test:
• Executing
• Execution pending
• Executed, passed
• Executed, failed

All selected tests are performed. 
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7 If any test failed, redo the test.

8 If failures still persist, contact Agilent service.

The results of diagnostics tests are stored in.xdy files in the 2100 Expert 
Installation folder under “..\diagnosis”. If tests fail, send the.xdy files to the 
Agilent service.
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Verifications     235

This chapter describes how you can validate your 2100 Bioanalyzer system.
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To ensure a validated Agilent 2100 Bioanalyzer system, verification steps have 
to be performed at installation and operation level. 2100 Expert Software 
allows for detailed installation verification and system verification on both 
the 2100 Bioanalyzer system hardware and software. Each verification 
comprises a series of tests and measurements that you can run and document 
in the Verification context of the 2100 Expert Software.

NOTE The 2100 Expert Security Pack restricts access to data and functionality to users who are 
logged in with certain roles. See User Role Model ( “Access Control” on page 39) for 
details.
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Installation Verification
Installation verification includes tests to verify that the 2100 Bioanalyzer 
system is installed properly and that all electrical connections are correct.

Installation verification must be performed once after installation.

System Verification
System verification proves that the 2100 Bioanalyzer system will function 
according to its operational specifications in the selected environment.

System verification should be performed:

• at first use of the instrument,

• after relocating the instrument,

• after changing essential parts of the system, for example software updates 
or exchange of cartridges,

• after instrument repair,

• on regular time intervals.

To perform verification tests:
1 Switch to the Verification context.

2 From the File menu select New.

A New Verification item appears in the Tree View Panel. Now it is possible to 
choose in the Tree View Panel from the possible actions: Installation Verification 
for hardware and software System Verification for hardware and software 

NOTE I you plan to perform a hardware verification please make sure that the correct instrument 
and cartridge is selected (displayed in the Configuration Tab)
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3 Under Cartridge Details, click Select and specify details on the cartridge that 
is currently installed in the 2100 Bioanalyzer instrument. Use the free-text 
Identifier field to specify cartridge details.

4 Under Configure 2100 Bioanalyzer HW Test Chips, enter the test chips you will 
use for this hardware verification (not required if performing software 
verification only):

NOTE To execute hardware tests the 2100 Bioanalyzer instrument must be properly connected 
and switched on.
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5 In the Tree View Panel, navigate to the test category you want to execute. 
Select the category via Installation/System Verification – Software/Hardware.

The Configuration tab now lets you select verification tests to be executed in 
the verification run:

To select tests, check the Apply check box next to the test(s).

6 To start the selected tests, click  button in the toolbar.

The Save As dialog box appears. 

You need to confirm this action with your electronic signature. 
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7 Specify a name and location for the verification results file (.xvd) and click 
Save.

The selected tests are executed.

8 If a test fails, you can Repeat test execution, Abort the verification run, or 
skip the current test and Continue with the next test:

After all tests have been executed the following message appears:
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9 Click OK.

The Status column shows which of the tests have been run successfully, 
which have failed, and which have mixed results with multiple executions. 
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10 To view details on test execution, select the Results tab.

11 You can now navigate to other test categories and execute additional 
verification tests.
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12 When you close the verification result file (File > Close), try to switch to 
another context, or exit 2100 Expert Software, the following message 
appears:

If you select No, you return to the Verification context and can run further 
verification tests.

If you select Yes, the verification result file (.xvd) is closed and becomes 
read-only. 

NOTE You can re-open verification result files only for viewing and printing.

HINT Select File > Print to generate a printed report of the verification run.
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This chapter lists all parts and accessories—including reorder numbers.
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Products, Spare Parts, and Accessories

To buy the following products, spare parts and accessories for the Agilent 
2100 Bioanalyzer system, please refer to our webpage:

http://www.genomics.agilent.com/en/

• G2939BA – Agilent 2100 Bioanalyzer System

Includes 2100 Bioanalyzer instrument, Start-up Service, Electrode 
Cartridge, 2100 Expert Software on CD-ROM and software license, 
accessories, IKA Vortex Mixer.

• G2953CA – Agilent 2100 Bioanalyzer System Upgrade Laptop

Includes HP laptop PC

Software and Services
• G2946CA – Agilent 2100 Expert Software Upgrade

Software package for upgrade to the latest 2100 Expert Software and 
licence.

• G2949CA – Agilent 2100 Expert Security Pack

Includes Security Pack software license for the 2100 Expert Software and 
Start-up Service.

Additional services for Installation Qualification (IQ) and Operation 
Qualification/Performance Verification (OQ/PV) and Operational Services are 
available and can be ordered separately.
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Spare Parts and Accessories
• 2110-0007 - Fuse

• 5042-1398 - Adjustable Clip for use as spare part for the chip priming station

• 5065-4401 - Chip Priming Station including gasket kit and adjustable clip

• 5065-4413 - 16-pin bayonet Electrode Cartridge

• 5065-9951 - Electrode Cleaner Box, contains 7 electrode cleaners

• 5067-1589 - IKA Vortex mixer, must be ordered at IKA (http://www.ika.de)

• 5067-1599 - IKA Vortex Mixer Adapter

• 8121-1013 - USB-Serial Adapter Cable 

• G2938-68100 -Test Chip Kit for Electrophoretic Methods, includes 1 
Autofocus, and 1 Electrode/Diode test chip

• G2938-68716 - Gasket Kit, includes spare parts for the chip priming station: 1 
plastic adapter, 1 ring and 10 gaskets

• G2938-81605 - RS 232 cable, (communication cable PC – Agilent 2100 
Bioanalyzer instrument)
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Area Threshold The Area Threshold setpoint determines the minimum amount of peak area that must be detected before a 
peak is recognized.

Assay An assay is a solution with defined chip, chemicals, instrument methods, data analysis, data output settings 
and data display settings.

Audit Trail Audit trails are available in the 2100 Expert Software only with the security pack installed. They are used to 
record the activities of the logged-in users and cannot be modified. The audit trails as well as log books are 
subject to data protection. Only authorized users are allowed to inspect them. They are saved with the data 
files or into an audit file repository, which is automatically archived.

Base pair A base pair (bp) is a unit of two nucleobases bound to each other by hydrogen bonds. The length of DNA or 
RNA molecules is often expressed in base pairs.

Baseline A baseline is established just after the First Peak Time setpoint. After the overall baseline is established, a 
local baseline is calculated for each peak to compensate for baseline drift.
For isolated peaks, the local peak baseline is simply a straight line connecting the Start Point of the peak with 
the End Point.
For peaks that are very close together, an average baseline is used when the value between the peaks does 
not drop to the actual baseline.

Baseline Plateau This setpoint (found in the setpoint explorer) rejects brief, low slope areas such as at peaks and between 
non-baseline-resolved peaks. The signal is recognized to be at baseline whenever the slope of the data is 
less than the Slope Threshold setpoint (either positive or negative) for longer than the time set for the 
Baseline Plateau.

BMP file BMP is the standard Windows image format. The BMP format supports RGB, indexed-color, grayscale, and 
bitmap color modes.

Bubble If the tip of a pipette is not positioned all the way to the bottom of a well, bubbles can result (and sometimes 
bubbles happen even when you are very careful). The vortexing step that occurs after samples are loaded 
into the chip is designed to rid the wells of bubbles and is usually very effective. If a large bubble is seen at 
the bottom of a well, remove the sample from the well, pipette it back in, and continue with the loading 
procedure.

Center Point After locating a start point, the peak find algorithm looks for the first negative slope value and saves the 
previous point as the center. If the value of the center point is less than the Minimum Peak Height, the 
algorithm starts looking for a new peak.

COM Port See Serial port.
Concentration Concentration is the amount of substance or solute per unit volume of solution. Concentration is measured in 

nanogram per microliter (ng/µL) within the 2100 Expert Software.
CSV file Comma-separated variable file. The simplest form of file for holding tabular data. Data is listed in columns in 

a text file, each value being separated by a comma. Each new line represents a new set of data. Import and 
export with Microsoft Excel is possible.
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Data Filtering The first step 2100 Expert Software takes in analyzing raw data is to apply data filtering. Data filtering is 
done by means of a polynomial “filter” that is applied to the raw data. The setting for the Polynomial Order in 
the setpoint explorer determines the amount of data to be applied: the smaller the number, the more data 
that is applied and the more filtering that takes place.

Data Points Data points are 0.05 seconds apart. 
Show Data Points is an option that enables the display of the data points used to generate the graph.

Electrode Cleaner An electrode cleaner should be used to clean the electrodes after each run is complete. The cleaning 
procedure is slightly different depending upon the type of assay that was just performed. 
The electrode cleaner looks like a chip except that it is clear. With RNA assays you must use two different 
electrode cleaners: one for general cleaning using RNAse-free water and another for decontamination using 
RNAseZAP. It is recommended to use a permanent marker to label the electrode cleaners so as not to mix 
them up.

Electrokinetic forces Electrokinetic forces are used to move, switch and separate the samples. Active control over voltage 
gradients directs the movement of materials using the phenomenon of electrophoretic flow.

Electroosmotic Flow A phenomenon that results from an electrical double layer formed by ions in the fluid and surface electrical 
charges immobilized on the capillary walls. When an electric field is applied, the bulk solution moves towards 
one of the electrodes. This phenomenon can be used to move fluids through microfabricated channels.

Electrophoresis A standard technique of separating molecules on the basis of their mobility (charge-to-mass ratios). An 
electrical potential is applied across a capillary containing a sample in a fluid medium. Positive molecules 
migrate towards the cathode and negative molecules migrate towards the anode at different speeds, 
depending on their electrophoretic mobility.

Electrophoretic flow A macroscopic phenomenon that results from an electrical double layer formed by ions in the fluid and 
surface electrical charges immobilized on the capillary walls. When an electric field is applied, the bulk 
solution moves towards one of the electrodes (cathode). Electrodes sit in the reservoirs that connect to the 
ends of the various channels. Electrode potentials are applied to the various reservoirs in a time-dependent 
fashion to move the fluid in the required direction. The gel-filled channels of the chips do not exhibit a 
measurable flow because of dynamic channel coating and viscosity of the polymer matrix.

End Point The peak find algorithm looks for a leveling off when the value of the slope is less than the value set for the 
slope threshold. This is considered to be the end point of the peak.

End Time This setpoint determines the time after the start of a run before which the last peak or fragment will be 
located (any peaks appearing after this time are ignored).

Filter Width This setpoint determines the width of the polynomial (in seconds) to be applied to the data for filtering (noise 
reduction). The default depends on the assay selected. This setting should be less than twice the width of the 
peaks of interest or the peaks will be distorted. Peaks that are distorted by the filter have positive and 
negative peaks on both sides. To see an example of such distortion, increase the filter width to 5.

Firmware The firmware is a program to control the hardware components of the Agilent 2100 Bioanalyzer instrument. 
It is downloaded from your computer to the Agilent 2100 Bioanalyzer instrument and controls, among others, 
data transfer or the measurement procedures.

GIF file Graphics Interchange Format, GIF is a graphics file format that uses a compression scheme originally 
developed by CompuServe. Because GIF files are compressed, the file can be quickly and easily transmitted 
over a network. This is why it is the most commonly used graphics format on the World Wide Web.
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Height Threshold The Height Threshold setpoint determines whether a peak is kept. It represents the minimal peak height. For 
each peak, the difference between the baseline height at the center position and the center height must be 
greater than the Height Threshold value.
This setting is chosen in the setpoint explorer.

HTML file HTML (Hyper Text Markup Language) is the authoring language used to create documents on the World 
Wide Web. HTML defines the page structure, fonts, graphic elements and hypertext links to other documents 
on the Web.

JPG file Joint Photographic Experts Group Image File. A JPEG file is a compressed raster or bitmapped graphic 
image. When a JPEG is created, a range of compression qualities may be considered. JPEG compression is a 
lossy process, which means that you sacrifice quality for file size the more you compress the image (the 
highest quality images results in the largest file size). Whereas GIF images are limited to 256 colors (8-bit), 
JPEG images may contain millions of colors (24-bit) as well as additional information including PostScript 
clipping paths.

Lab-on-a-chip The generic term for a microfluidic product, signifying a chemical process or material movement taking place 
on a microchip. In contrast to analysis in a standard laboratory that relies on human intervention at several 
stages to manipulate or observe samples and record results, the self-contained lab-on-a-chip represents an 
almost hands-free technology.
Lab-on-a-chip technology means downsizing of analytical techniques from lab-scale to chip-scale:
- using techniques like electrophoresis, chromatography, and sieving.
- with fluorescence, absorbance, and MS detection.
- with a higher degree of automation, integrating multiple steps of a complex protocol into a miniaturized 
system.
Virtually any biochemical testing that can be done in a laboratory can theoretically be done on a chip.

Ladder Each electrophoretic kit contains a ladder. A ladder contains DNA, RNA fragments or proteins of known sizes 
and concentrations. 
A ladder well is located at the bottom right of the chip. The ladder is analyzed first before sample analysis 
takes place.
The peak sizes and markers defined for the ladder are assigned consecutively, starting with the first peak 
detected in the ladder. Peaks appearing above the upper marker do not have to be detected. The peak table 
for the ladder well shows the peak size and concentration.

Lower Marker An internal standard that is added to a sample in a well to assist in determining size of the sample. The lower 
marker is the same as the first peak found in the ladder.

Method Methods are available in the 2100 Expert Software only with the Security Pack installed. A method is 
referred to as an electrophoretic assay with additional information stored to it. This additional information 
includes instrument information, study information, report settings, and workflow definitions.

Microfluidics The movement of liquids through micro-fabricated structures by means of electrical fields or 
pressure/vacuum, holding the promise of greater functionality with significantly improved reliability:
- small glass or plastic devices with micro-channels as experimental platform
- active control of fluids without moving parts on-chip through miniature electrodes or pumps controlled by 
software scripts
- emulation of conventional liquid pumps, valves, dispensers, reactors, separation systems, etc.
- capability of liquid transfer, separation, dilution, reactions and more
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Molarity Molarity is the number of moles of solute per liter of solution. Molarity is calculated as nanomoles per liter 
(nmol/L) within the 2100 Expert Software.

PDF file PDF (Portable Document Format) is a file format created by Adobe Systems Incorporated that preserves all 
of the fonts, formatting, colors, and graphics of any source document, regardless of the software and 
computer platform used to create it.

Peak Baseline A local peak baseline is calculated for each peak. For isolated peaks, the local peak baseline is simply a 
straight line connecting the start point with the end point. For peaks that are very close together, an average 
baseline is used when the value between the peaks does not drop to the actual baseline.

Peak Filter Width The Peak Filter Width setpoint determines the minimum amount of time that must elapse before a peak is 
recognized.

Peak Height The value at the center point of the peak minus the local baseline start value.
Point-to-Point Fit This curve fit is composed of line segments between each pair of data points that are used to interpolate data 

between those points.
Polynomial Filter The first step 2100 Expert Software takes in analyzing the raw data is to apply data filtering. Data filtering is 

done by means of a polynomial “filter” that is applied to the raw data.
Priming Station Consists of a chip holder that has a syringe mounted on the lid that seals over the chip. The syringe is used to 

force the buffer solution loaded into the well marked “G” with a circle around it into all the passageways 
inside the chip prior to running it in the 2100 Bioanalyzer instrument.

Serial port The serial ports (COM ports) are used to connect your computer with the Agilent 2100 Bioanalyzer 
instrument. If your computer does not have a serial port, you should use the Agilent USB to Serial Adapter 
(8121-1013).

Signature Signatures are available in the 2100 Expert Software only with the Security Pack installed. All activities on 
data such as creating or modifying data must be confirmed by the user with an electronic signature (user 
name and password). By requesting this signature it is ensured that only authorized users can create or 
modify data.

Slope Threshold The Slope Threshold setpoint determines the difference in the slope that must occur in order for a peak to 
begin. The inverse of this value is used to determine the peak end.

Standard Curve The standard curve is obtained by plotting the size of the ladder peaks vs. time using a point-to-point fit. For 
each sample peak, the center time is interpolated from the Standard Curve to determine the peak size in base 
pairs.

Start Point The peak find algorithm walks the data from time zero looking for a slope greater than the Slope Threshold. 
This is considered to be the start point of a peak. 
With RNA assays, individual peak start times can be moved manually by dragging the diamond-shaped start 
points shown in the single view.

Start Time This setting determines the time after which the first peak or fragment will be located (any peaks appearing 
before this time are ignored). In RNA and Protein assays, the start time is shown on the single view display as 
a long-dashed vertical green line (note that this is true for protein assays when analysis is on; the start time is 
shown as a solid green line when analysis is off for protein assays). With RNA assays, another start time 
setting is available that determines the start time for an individual peak. 
With RNA assays, individual peak start times can be moved manually by dragging the diamond-shaped start 
points shown in the single view.
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Size Size or length of nucleic acids is calculated in base pairs (bp) in reference to a sample with molecules of 
known length.

Tool Tip A small box containing text that describes the item indicated by the mouse pointer. To view a Tool Tip, 
position the mouse pointer over an object on the screen. Leave the mouse stationary for a moment and a Tool 
Tip (if one exists for that item) will appear.

TIF file A file extension indicating one of a set of popular bitmap graphics formats. Tiffs are commonly used in DTP 
work because of their support for color specification.

Upper Marker An internal standard that is added to a DNA or Protein sample in a well to assist in determining size and 
concentration of the sample. The upper marker is the same as the last peak found in the sizing ladder.

WAV file A type of computer file used to store a sound digitally.
Workflow The workflow defines the order of steps that need to be taken for a measurement to ensure data validity and 

data reliability. This includes steps such as the execution of methods, result reviews, and the final approval. 
The workflow definition is part of the methods and is available in the 2100 Expert Software only with the 
Security Pack installed.

WMF file Windows Metafile. Windows metafile documents can contain any mix of vector and raster (or bitmapped) 
information to describe the contents of an image. WMF graphics are generally used on the Windows 
platform as a standard format for clip art and other graphically rich information such as charts.

XAD file 2100 Expert Software chip data file. The files contain raw data, assay information, data analysis setpoints, 
information on chip, samples and study, and the run log information.

XAC file 2100 Expert Software comparison file.
XLS file Microsoft Excel spreadsheet file. 

XML file Extensible Markup Language files. XML is the Extensible Markup Language, a system for defining specialized 
markup languages that are used to transmit formatted data. XML is conceptually related to HTML, but XML 
is not itself a markup language. Rather it is a metalanguage, a language used to create other specialized 
languages. 
2100 Expert Software uses the XML format to:
- export chip data
- save and load result flagging rules.

XSY file 2100 Expert Software assay file. The files contain the assay properties, data acquisition settings, and 
information on chip, samples, and study.

XVD file 2100 Expert Software verification result file. The files contain results of verification tests regarding the 2100 
Bioanalyzer system hardware and software. xvd. files are stored in the “..\validation” subfolder of the 2100 
Expert Software installation directory. For each verification run, an .xvd file is generated. 
Date and time of the verification run are included in the file name. Example: 
“Verification_23-05-2005_10-28-40”.

Zero Baseline All electropherograms produced with the 2100 Bioanalyzer system show some amount of background 
fluorescence. By default, the 2100 Expert Software enables the zero baseline function. Enabling this setting 
offsets the graphs shown for the individual wells but does not affect analysis. The mean of 100 points before 
the baseline time (derived when calculating well noise) is used as the zero baseline value.
To remove the zeroing, disable the Zero Baseline box in the setpoint explorer (baseline calculation under 
Global and Advanced setting).
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